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Welcome to the Fitrix , Visual Development Tool (VDT) Report Tools Course Workbook.
This manual is designed for use in the Fitrix VDT Training class. We hope that you find
all of this information clear and useful.

The screen images for the Report Writer product are all 'Character Screens'. The Fitrix
'Report Writer' is a character based end user report writer that can be used either for end
users to create simple reports, or as a front-end for the Fitrix Report Code Generator'. The
Fitrix Report Writer is not available in Windows Graphical Mode, but can be run from a
Windows desktop in character mode.

The Fitrix Report Code Generator creates report and posting programs in 4GL. Any pro-
gram created by the Report Code Generator offers the option of being viewed in a graph-
ic based Windows screen.

If you have any questions about how to view your products in graphical mode, please con-
sult your Installation Instructions or contact the Fitrix help desk at 1(800)374-6157. You
can also contact us by email: support@fitrix.com. Please be prepared to offer your name,
your company, telephone number, the product you are using, your Fitrix serial number and
your exact question. We hope you enjoy using our products and look forward to serving
you in the future.
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Preface

The Report Training Course Workbook is an aide for training
on the products that make up Report. This workbook serves
as a supplement to classroom training offered by . This

workbook is not designed to be used by itself as a self study tutorial.

This workbook covers the following CASE Tools products:

. Report (Report Writer, Report Code Generator, and Fea-
turizer)

¢ 132 Column Pager

This workbook does not cover the following CASE Tools

products:

. Screen (Form Painter, User Control Libraries, Screen
Code Generator)

. Menus

This workbook is divided into three parts; each part addresses a sepa-
rate audience:

* Sections 2 through 4 address end-users with no technical knowl-
edge, who use Report Writer to create reports.

* Sections 2 through 5 address system implementors with some
technical knowledge, who set up and support end-users.

* Sections 1 through 8 address programmers with extensive techni-
cal knowledge, who modify report code for end-users.



Introduction to
Report

Major topics in this chapter include the following:
M Starting the Report Writer
MW Using Report Writer’s menus

B Creating a simple report
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Starting the Report Writer

Start Report Writer by typing £g.writer at the UNIX prompt. If
DBNAME is set in your .profile, there is no need to specify the name
of the database prior to entering the program. If you need to, this is
done by passing a “-d” flag to fg.writer, e.g., fg.writer -4
stores{}.

standard: Report Delete Options Help Quit
Load, save. and print reports

1-2 Introduction to Report
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Report Writer’'s Menus

Report Writer ring menu is the user interface for report-
ing information stored in the database without entering structured
query language code. Notice that the database name, in this case
*report,” is identified to the left of the ring menu options.

Each option on the main ring menu identifies a pull-down menu with
additional options for activities in Report Writer. To move between the
menu options, type the first letter of the menu option or press the

arrow keys and press [ENTER] to display the selected option’s pull-
down menu.

File Pull-Down Menu

The File menu lets you create and maintain report files.

standard: Report Delete  Options  Help  Quit

Load a Report >>

Print Report >>
1Save the Report
Import/Export

Exit the Program

To select an option on the File pull-down menu, press the first letter
of the option or use the arrow key to move to the option and press
[ENTER]. The pull-down menus contain two characters which either
proceed or follow the menu option. When an option is proceeded

Report Writer's Menus 1-3
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with a !, the menu option is not available at the current time. When an
option is followed by >>, selecting this option causes additional
options to appear.

The File pull-down menu options include the following:
New Report leads you through the Report Definition and creates
a new report file.

Load a Report provides a list of existing report files and allows
the user to load an existing report.

Print a Report lists existing report files and prints the selected
report.

Save the Report saves a newly created or edited report file.

Import/Export allows the user to store report definitions in a text
format. The format is saved in a file, which can be imported into
another database.

Exit the Program confirms that the user is ready to quit and exits
to the UNIX prompt.

Report Pull-Down Menu

1-4

The Report menu option lets you build a new report or modify a cur-
rent report.

standard:  File Delete Options  Help  Quit

ain Description...

{Choose Columns >>
irrange Columns...
IGroup and Sort...
!Edit the Report...
{Rebuild the Report

1Selection Sets...

Introduction to Report
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You must be working with a current report or have begun a new
report description before these options are available.

The Report menu options include the following:

Main Description brings up the Report Description Form, where
you define the report parameters. Parameters include database
information, report format, who created the report, and when it
was created.

Choose Columns lists the available columns for your report
based upon the database information you enter into the Report
Description form.

Arrange Columns lets you define the order that the columns will
appear on the report and mark which columns are totaled.

Group and Sort allows you to specify a column or sequence of
columns by which to sort the report.

Edit the Report allows you to make modifications to the report
template that is created by the Report Writer.

Rebuild the Report removes any modifications performed dur-
ing the current work session by reverting to the most recently
saved copy of the report. '

Selection Sets allows you to define selection criteria to define the
data displayed in the report.

Report Writer's Menus 1-5
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Delete Pull-Down Menu

The Delete menu lets you remove old report files and other data files
used by the Report Writer.

stendard: File  Report Options  Help  Quit

Selection Sets >»>
Grouped Reports >>
Formats >>
Printers >>

Data Groups >>
Relationships >>

The Delete pull-down menu options include the following:

Old Reports lets you delete a saved report.
Selection Sets lets you delete selection sets.

Grouped Reports lets you delete selected groups of reports
defined under the Options menu.

Formats lets you delete selected formats defined under Options.
Printers lets you delete printer definitions defined under

Options.
Data Groups lets you delete selected data groups defined under
Options.

Relationships lets you delete selected table relationships defined
under Options.

1-6 Introduction to Report
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Options Pull-Down Menu

The Options menu lets you define and maintain report and database
files.

standard: File  Report  Delete Help  Quit

Printers >>
Group Reports >>

Table/Columns >>
Data Groups >>
Relationships >>

The first three options let you set up reference files.

Formats allows you to define multiple page templates for the
report’s output. Formats define the column width, length, and
margins.

Printers is the form on which you set up the printers to be used to
print reports.

Group Reports allows you to organize reports into like groups.
The last three options let you perform data administration tasks.

Table/Columns allows you to assign desc;.riptive names to the
tables and columns in your database.
Data Groups allows you to organize tables into logical groups.

Relationships allows you to define relationships between tables
in the database. These relationships, or “joins,” should be defined
by the data dictionary manager.

Report Writer's Menus 1-7
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Help Pull-Down Menu

The Help menu lets you view detailed help information.

This includes context-sensitive help and general discussions on data-
base administration, creating reports, and editing reports.

standard: File  Report  Delete  Options Quit

Jontext Help... —_—

General Help
Database
Column Selection

Editing Reports
Sort/Selection
Running Reports
Miscellaneous
Acknouledgements

Quit Pull-Down Menu

The Quit menu lets you quit Report Writer.

After selecting the Quit option, you are asked to confirm your
request. Select YES if you want to quit, NO or CANCEL if you want
to continue using Report Writer.

1-8 Introduction to Report
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Creating a Simple Report

You can create several types of reports using the Report Writer.

When creating a report, follow these basic steps:

1.
2.

Print or save the report.

Report Description Window

Identify the data to be used in the report.

Define any totaling, or data manipulation, that results in a dis-
play element.

Format how the data appears on the report.

The Report Writer automatically leads you through the steps of creat-
ing a new report. The first steps to creating a new report include cre-

ating the report definition:

1. Select the Data Group

2. Choose a Table

3. Choose a Report Format
4. Name the Report

Report Description
LESCY to Store [DEL] to Cancel

L[CTRLI-Lw] Help

Database : standord

Report Newe : [ITITTEACRC SN

Data Group : Demo Data Set

Table Name ¢ Customer Information

Table : customer

Selection Set

Report Format : 80 column

Report Hidth Left Margin 5
Right Margin S

Report Length 66 Top Margin 5
Bottom Margin 5

Author : brianh Private Report? :

Date Changed : Date Created : 05/709/94

Enter the name of this report.

Creating a Simple Report
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Report Writer then leads you through the steps to creating a specific
report.

5. Select the columns in the report

6. Arrange the columns in the report.

Arrange Columns to Display on the Report
LESC] to Store LDEL] to Cancel

-~ Sequence - Column Total? —-
1 Customer Number
2 Company Name
3 City
4 Phone Number

Enter the order of the column on the report.

Once the base report description information is defined, Report Writer
automatically creates a report template.

Automatic Report Template

The report template appears on the screen in the Report Editor.

standard: Report  Delete  Options  Help  Quit
Load. save. and print reports
10 20 30 40 50 60 70
5:
[date 13 [title 1 Page: [
Cust No | S— ]
1 Company Name [ ]
City [ |
Phone L _— 2]
15 :
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This template displays a preview of your report layout and how your
report will appear when it is printed.

Print the Report

To print the report, choose a destination to which to send the report.
You have the following options:

LENTER] Select EDEL] Exit

Choose a Destination

Output to Printer
Hrite to File
Archive to Database

Export Data >>
Reporting Options >>
Quit

Display to Screen displays the report to the screen. You can
move through the report using the options on the Pager ring
menu.

Output to Printer prints a hardcopy of your report to the selected
printer.

Write to File saves the report to a file.
Archive to Database stores the text of your report in tables in the
database.

You can also select one of the following:

Export Data prints the report to an ASCII file.

Reporting Options allows you to define several options to con-
trol the detail of the report. These options include Summary Only,
Test Length, Form Alignment, Data Selection, and Store Raw
Data.

Quit returns you to the File pull-down menu.
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Displaying a Report to the Screen

If you choose to display the report to the screen, the report appears in
the Report Pager.

Pager:jj Prev Right Left Top Bottom Scroll Up-scroll Quit
View the next page.

05709794 Customer Report Page: 1
Cust No 101

Company Name All Sports Supplies

City Sunnyvale

Phone 408-789-8075

Cust No 102

Company Name Sports Spot

City San Francisco

Phone 415-822-1289

Customer Report: columns 1 to /6 lines 1 to 18 of 132

The Pager ring menu options help you to view different sections of
the report. Move the cursor to the self-explanatory ring menu selec-
tions using the arrow keys or by keying the first letter of the selection,
which is capitalized. Press [ENTER] to execute the command.
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Section Summary

B From the Report Writer ring menu, you perform most reporting
activities using the File and Report menu options.

B You manage your data dictionary management and perform
delete activities from the Delete and Options selections on the
ring menu.

M To create a simple report, identify the data to be used in the
report, define manipulations to the data, format how the data
appears on the report, and print or save the report.

MW Report Writer gives you the ability to set up and maintain a data
dictionary using the options for data administration under the
Options menu.
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Lab Exercise 1

Objective: Create a simple report and display it to the screen.

Start Report Writer

1.

Execute Report Writer using the storest} database by typing:
fg.writer -d stores{}

Substitute the name of your database for stores () or set
$DBNAME to the name of your database and leave off the -d flag.

Create a Simple Report

The first step to creating a new report is to define the report descrip-
tion. Report Writer will lead you through this process.

1.
2.
3.

From the File pull-down menu, select “New Repoﬁ.”
Choose “Demo Data Set” as the Data Group.

Choose the “Customer Information” table.

if the Report Format box appears, press [DEL].

Name the report “Customer Phone Numbers.”

Press [ESC] to store the Report Description.

Use the arrow keys to move to the following columns and press
[ENTER] to choose the columns to appear on the report.
Customer Number

Company Name

Phone Number

Note When you choose a column, an asterisk will appear next to the
column name indicating this column is selected. To remove a
column, press [ENTER] again to toggle off the column selection.
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7.
8.

10.

Press [ESC] to store the columns in their default order.
Accept the sequence shown by pressing the [ESC] key.

Notice how the report template is displayed on the screen behind
the menus.

Press [DEL] to avoid choosing a Selection Set.

Press [DEL] again to clear any open pull-down menus and view
the entire report template.

At this time a preview of the report template is visible on the
screen. As you are working with more detailed reports, you can
view the effects of any changes made in your report definitions as
you are making them.

Display the Report to the Screen

1.
2.

From the File pull-down menu, select “Print Report.”

Press [ENTER] to save the report, with the default name: “Cus-
tomer Phone Numbers.”

If prompted for a Selection Set, press [DEL], as you have yet to
define any selection criteria.

Select “Display to Screen” to display the “Customer Phone
Numbers” report to the screen.

Use the Pager ring menu options to move through the report.
Select Quit to return to the Report Destination window.

Press [DEL] or Quit to return to the Main Report Writer menu
and exit the program.
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Major topics of this chapter include the following:

Manipulating Report Data
Printing Reports
Grouping Data in a Report

Creating Selection Sets
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Creating a New Report

The Report Writer leads you through the basic steps of creating a
report. As you begin creating a report, you define the report descrip-
tion, choose the columns to appear on the report, and specify the
order in which they should be arranged.

Defining the Report Description

2-2

To define a report description:

1. Choose a data group. A data group is a predefined group of
related tables in your database. Defining data groups allows you
to organize related tables in your database from which you can
create your report. Data groups are defined by the database
administrator using the Options selection from the main ring
menu.

2. Choose a Table. The list of tables displayed are familiar names -
describing all the tables in the selected data group.

3. Complete the Report Description. Once you have selected the
data group and main table, you are led to the Report Description
window. This form is divided into three sections.

Report Description

[ESC] to Store [DEL] to Cancel E£CTRLI-[w) Help
Database : standard

Report Name

Data Group : Demo Data Set

Table Name : Customer Information

Table : customer
Selection Set :

Report Format : 80 column

Report Hidth 80 Left Margin S
Right Margin S

Report Length : 66 Top Margin S
Bottom Margin 5

Author : brianh Private Report? :

Date Changed : 05/09/94 Date Created 1 05/09/94

Enter the nawe of this report.

Creating Reports
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The top section contains report file information. You assign a
name to the report here. This name prints at the top of your
reports.

The middle section contains the report format information.
Report formats are predefined under Options. A format is a pre-
defined page size for your report. The type of information set in
the report format is the report column width, report length in
number of lines, and margin spacing.

The bottom section identifies who created the report, when it was
created, and when it was last changed. You also have the ability
to define the report as a private report available only to the
author.

Choosing the Columns to Appear on the Report

You are automatically led to the next logical step in creating a report:
selecting which columns the report will use. The columns listed are
the columns found in the main table defined in the report description.
You are not limited to reporting from these columns. You can also
select columns from tables that are defined as being related to or
joined to the main table. The columns are listed by their familiar, or
descriptive, names.

From this screen, there are two ways to select columns to appear on
the report.

1.

Move to the column name using your arrow keys and press
[ENTER] to select the column. Note that an asterisk (*) appears in
front of the column name indicating that this column has been
selected.

Press [CTRL] - [z] and you will be prompted to select a data file.
A list of columns is displayed for you to select from. The data
files are other tables that have a relationship to the main table
defined in the report description. In addition to selecting columns
from the main table, you have the option of selecting columns
from related tables. Table relationships are defined by the data-
base administrator from the Options pull-down menu.
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Arranging the Columns to Display on the Report

24

The next step is to arrange the columns in the order you want them to
appear on your report. In addition to arranging the order of the col-
umns for the report, you can add a column and total numeric column
values.

The columns appear in the order they were selected. To change their
order on the reports, alter the number in the Sequence field. For
example, entering “1” (for “Item Description”) in the Sequence field
indicates that it will be the first column of the report. It will appear
either as the column on the far left of the report or as the first column
if the report data is stacked.

Arrange Columns to Display on the Report
[ESC] to Store [DEL] to Cancel

- Sequence - Column Total? -
Customer Number
Company Name
3 City
4 Phone Number

Enter the order of the column on the report.

You can add another column to the report from this entry screen by
typing a column name under the Column field. You also have the
option of totaling a column by entering “Y” in the Total field.

Once you have stored your column arrangements, the Report Writer
displays the template in the background of the pull-down menus,
allowing you to preview the report layout as you create it.

Creating Reports
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When you select the Print Report option, you will be prompted for a
name. You will be asked to specify a selection set. Once you have
named the report and specified the selection set, you can choose a
destination for the report. You have the following options:

[ENTER] Select [DEL] Exit

Choose a Destination

tisplay to Screen

Output to Printer
Write to File
Archive to Database

Export Data >>
Reporting Options >>
Quit

Display to the Screen

This option sends the output of your report to the screen. Use your
arrow keys to highlight an option and press [ENTER] to select it. You
can also type the first letter in the option’s name, such as “p” for Prev

(Previous) to highlight it.

View the next page.

Pager :|j Prev Right Left Top Bottom Scroll Up-scroll Quit

Custower Report Page: 1

Customer Report:

05/09/94

Cust No 101

Company Name All Sports Supplies
City Sunnyvale

Phone 408-789-8075

Cust No 102
Company Name Sports Spot

City San Francisco
Phone 415-822-1289

columns 1 to 76 limes 1 to 18 of 132
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2-6

Report Pager Ring Menu Options
e Next allows you to page down and view the next page.
¢ Prev allows you to move back up to the previous page.

¢ Right allows you to move the screen display to the right, should
you have more columns across the report than are displayed to
the screen.

e Left allows you to move the screen display of the report back to
the left.

¢ Top allows you to move to the top of the report.

e Bottom allows you to move to the end of the last page of the
report.

¢ Scroll allows you to move down through the report one line at a
time.

e Up-scroll allows you to move up towards the beginning of the
report one line at a time.

¢ Quit exits from the report display and returns to the Select Desti-
nation menu.

Output to Printer

Prompts you to choose from the printers set up to print reports, and
routes your report to the printer.

Write to File

Prompts you to enter a file name for the report’s destination, and
saves your report to the file.

Archive to Database

Stores the text of your report in two tables in the Report Writer data-
base.

Export Data

Outputs the detail of your report to an ASCII file, which can be
imported by other software programs.

Creating Reports
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Reporting Options
Allow you to define several options to control the report output.

Detail or Summary toggles between printing detail only or sum-
mary only. Detail prints out every row of the report. Summary
prints only group headings and their corresponding subtotals.

Test Length allows you to define how many rows to print. Use
this to preview a sample before printing the entire report.

Form Alignment allows you to send positioning marks to the
printer so you can see if the forms are aligned properly.

Data Selection allows you to select multiple selections sets for a
report.

Create Data Table stores the raw data of your report to a table,
allowing subsequent reports from this table to run faster.
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Manipulating Report Data

Report data can be manipulated by the following methods: changing
the Arrange column sequence, grouping data and calculating subto-
tals, and sorting the data.

Once you have created a report you may want to make editing
changes to that report or to another saved report.

Loading a Saved Report

To load an existing report, from the File pull-down menu select Load
a Report. A screen is displayed prompting you to Choose a Report.
The options are divided into two parts:

1. The first contains Current Report or Last Report. Selecting Cur-
rent Report will return you to the report on which you are work-
ing. Selecting Last Report loads the last report you were working
with.

2. The second portion of this screen displays a list of all reports cre-
ated and saved for this database:

CENTER] Select [DEL] Exit

Choose a Report

2-8

OnFirstRou
Last Report Orders

Orders Listing
Customer Listing Report A
Customer Orders Report B

Customer (rders Summary
Customer Phone Number

Customer Report
Demo Report
Example
Football Report

Informix Bug Report

New Listing

Sales Summary
Salesman Test
Heekly Picks
ap/o_agedtl .dgs
ap/o_vendld.d4gs
big rpt test
davidh

dougs test

Page 1 of 2
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Editing the Report Data

Editing options can be accessed from the Report pull-down menu.
The first three options on the Report pull-down menu access the
input programs that the Report Writer automatically leads you
through when creating a new report. Changes to column information
can be entered by selecting one of the first three options.

¢ Main Description allows you to modify the report file definition.

¢ Choose Columns allows you to change the selection of columns
for the report. If changes are made to the columns selected for the

report, the program automatically brings up the Arrange Column
screen.

¢ Arrange Columns allows you to change the column display on
the report or define a column for totalling.

The four selections following allow you to create more complex
reports.

¢ Group and Sort allows you to define criteria to group data, and
to sort the display order of the data.

¢ Edit the Report allows you to access the report template viewed
on the screen and make changes to the report through the tem-
plate.

¢ Rebuild the Report recalculates the math functions and redraws
the report template display.

¢ Selection Sets allows you to create a new selection set or choose
from defined selection sets. A selection set specifies the selection
criteria for data included on the report.

Grouping and Sorting

More functionality can be added to your report by defining a column
to group data by, and to sort the data in ascending or descending
order. When Group and Sort is selected, the list of columns chosen for
this report is displayed. When a column is chosen as a group, that col-
umn will appear as a subheading for the group. If any columns in the
report are marked for totaling, a subtotal will be calculated for each
group defined.
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Once a column is selected, the Sort the Report by these Columns
screen is displayed.

Sort the Report by these Columns
LESC] to Store [DEL] to Cancel

- Seq - Sort? - Group? - Page Bk.- Column
1 Y N Customer Number
2 Y N Order Number
Y N Item Number

Enter order of the column for sorting.

® Seq is an abbreviation for sequence. If you have data grouped by
more than one column or criteria, define the sequence by which
to sort the columns. In the above example, data will first be
grouped by the Customer Number then by Order Number.

e Sort? allows you to sort a column in “A” (ascending) or “D”
(descending) order.

¢ Group? allows you to mark columns that you want subtotaled. A
“Y” indicates the column will be subtotaled.

e Page Bk. is an abbreviation for page break. You can define a page
break before or after a grouping, or select “N” for no page break
at all. The above example has an “A” defined for Customer Num-
ber. This will print a new page for each customer number group.

¢ Column displays the name of the column which is to be grouped.
By using [CTRL}-{z], you Zoom to additional columns that can be
added from this input screen.
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The following report template has two groups defined. The first
group appears with the subheading Customer Number. The second
group, indented under the Customer Number subheading, is Order
No. Each grouping has a corresponding subtotal calculated for the
Extension column, which is marked for totaling.

standard: File Delete Options Help Quit
Build and modify a report

[date 1] [title ] Page: [

Cust No: [_____. 1

Order No: [___
Company Name City Extension

€ 1t 1L ]
Subtotals for [ s —

Subtotals for [ 1 e

Below is the report displayed to the screen:

Pager ] Prev Right Left Top Bottom Scroll Up-scroll Quit
View the next page.

05709/94 Customer Report Page: 1
Cust No: 101
Order No: 1002
Company Nawe City Extension
All Sports Supplies Sunnyvale $960.00
All Sports Supplies Sunnyvale $240.00

Subtotals for 1002 ———————

Subtotals for 101 e
Customer Report: columns 1 to 76 lines 1 to 18 of 264
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Selection Sets

A selection set is a group of columns and their selection criteria that
determine what data is displayed on the report. Selection sets are not
tied directly to any given report. A report and a selection set are two
independent elements. All reports that share the same main table (as
defined in the report definition) can use any selection set that uses the
same table as the main table.

Defining Selection Sets

2-12

From the Report pull-down menu, Selection Sets can be chosen to
define a new selection set or modify an existing set. If no previous
selection sets have been defined, the only option on the Choose Selec-

tion Set menu is New Selection Set.

The first step to defining a selection set is to choose the column by

which to select or sort the data.

Once a column has been chosen, the Sorting and Data Selection Col-
umns window appears.

Sorting and Data Selection Columns
[ESC] to Store [DEL] to Cancel

(Zoom)==

- Sequence - Sort? - Selection Data =-~---—- Column
1 h Customer Nuber

Data to select for this column.

Note that this screen looks similar to the Arrange Columns screen
and the Group and Sort screen, but there is a new column, Selection
Data.

¢ Sequence lets you prioritize the columns for sorting.

e Sort? allows you to sort in “A” (ascending) or “D” (descending)

order.

Creating Reports
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¢ Selection Data lets you define your selection criteria.

¢ Column displays, adds, or updates columns for selecting and
sorting.

Selection Data

The Selection Data field allows you to build simple or complex selec-
tion clauses to limit the data displayed on your report. There are two
ways to enter a selection clause.

1. If you are familiar with SQL “select” statements, you may manu-
ally enter your SQL selection clause by typing it directly into the
Selection Data field.

The Selection Data field can store an SQL statement up to 100
characters long. If your statement requires more than 100 charac-
ters, then you can continue on the next row of the Data Selection
field. The following key strokes can be used for editing your
select statement:

¢ [CTRL] - [a] inserts a space

e [CTRL] - [x] deletes a character
e [CTRL] - [d] delete to end of line
e [CTRL] - [u] undo an edit

2. If you are not familiar with SQL selection statements, there is a
Zoom on the Data Selection field which helps you build your
selection statement.

Ends Hith

Matches = ——o—mo—meeee—
Equals Doesn”t Equal
Is in List Doesn”t Match
Between Is Not in List

Contains

Selection Sets 2-13



Report Training Course Workbook

A list of operators is displayed for you to choose from. Once you
have selected an operator, you are prompted for more specific
selection criteria. Comparison operators differ depending upon
the type of column, that is, whether it is character, numeric, or
date column.

Once you have entered the criteria, another window appears
allowing you to define an “And” clause, which further restricts
the selection. You can also choose an “Or” clause, which expands
the criteria.

ind (more restriction - less data)

or (alternative selection - more data)

Done (no more criteria)

2-14 Creating Reports
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Section Summary

When creating a new report, the Report Writer automates the
steps to create a basic report. These steps include the following:

¢ Defining the report file description.

¢ Selecting the columns to appear on the report.
* Arranging the columns to appear on the report.
¢ Viewing the report template.

Column templates can be modified and edited using the options
under the Report pull-down menu.

The report template, which appears in the background of the
pull-down menus, allows you to view the changes made to the
report definition while you are making them. You do not have to
print or display the report to view your changes.

Reports can be:

» displayed to the screen,

¢ sent to a defined printer,
e written to a file,

¢ archived to the database,
¢ exported to an ASCII File.

Report data can be grouped by a specified column or by multiple
columns. Subtotals are printed for grouped data columns.

Selection sets are defined to limit which data appears on the
report. Selection sets are independent of individual reports. They
are tied to the main table defined in the report description and
can be used for any report with the same main table definition.

Selection data can be entered in the following two ways:
¢ Typing an SQL select statement in the Selection Data field,

¢ Zooming to define selection criteria.
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Lab Exercise 2a

Objective: To create a new report that will display all sales orders and
their items. The total of all orders will appear at the bottom of the
report.

Defining the Report Description
1. Create a new report using the Demo Data Set.
2. Select the “Sales Orders” table.
If the Report Format box appears, press [DEL].

3. Name the report “Orders.”

Choosing the Columns to Appear on the Report

1. Choose the following columns to appear on the report and
arrange them in the following order:

e  Order Date

¢ Quantity (From the Line Items table)

¢ Line Extension (From the Line Items table)
2. Total the amounts in Line Extension column.

3. Save and display the report to the screen.

Adding Columns and Rearranging the Column Order

1. Return to the Choose Columns window and add the following
columns to the report. (These columns are in the Items in
Inventory table.)

e Item Number
e Item Description

e Unit Price
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Arrange the columns in the following sequence:
* Order Date

¢ Item Number

¢ Item Description

®  Unit Price

¢ Quantity

¢ Line Extension

Display the report to the screen.

Lab Exercise 2a 2-17
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Lab Exercise 2b

Objective: To expand the Orders report by adding subtotal logic to
the Order Number and Customer Number columns; and by calculat-
ing a total for all Customer Orders.

Grouping Report Data

Sorting Data

1.

2-18

1.

From the Report pull-down menu, select the Group and Sort
option. ’

Group your report by the Order Number column and sort the
orders in ascending order.

Notice the change in your report by viewing the report template
behind the pull-down menu.

Add an additional group, Customer Number, with a grouping
sequence of 1.

Orders on the report will be grouped within customer numbers,
so customer numbers will be your first group.

Save this report under the new name “Customer Orders.”

Add a page break so a different page is printed for each cus-
tomer.

Add a third column, Item Number, for sorting only.

It is not necessary to group orders by the Item Numbers as they
are already grouped by order number.

Save this report under a new name: “Customer Orders Sum-

”

mary.

Display the report to the screen and page down through each
customer order.

Creating Reports
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Lab Exercise 2¢

Objectives: You will define two Selection Sets, first, to select only cus-
tomer orders for footballs, then you will be entering an SQL filter
statement directly in the Selection Data field.

Selection Criteria

AN A

N

Load the “Orders” report.

From the Report pull-down menu choose “Selection Sets.”
Add a new selection set.

Zoom to the Inventory Items table.

Select Item Description as the column for selection criteria.

For Item Description, define the Sequence as 1 and sort in
ascending order.

Zoom on the Selection Data column and select Equals.
Enter “football” as the data criteria.

Save the selection set as “Footballs,” but do not define this as
the default for the Orders report.

10. Print the Orders report with Footballs as the selection set.
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Entering an SQL Filter Statement

2-20

1.

Load the “Orders” report and choose “Selection Sets” from the
Report pull-down menu.

Choose a new selection set.

Choose the Payment Date column as the column by which to
select data.

In the Selection Data column, type the following SQL select
statement: @ is null

Save the Selection Set under the following name: “Unpaid
Orders.” Do not define this as the default Selection Set for the
“Orders” report.

Print the “Orders” report so that it shows unpaid orders only.
Print the “Orders” report so that it shows all orders.

Print the “Customer Orders Summary” report of all unpaid -
orders.

Print the “Customer Orders Summary” so that it shows all
orders.
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Major topics in this chapter include the following:

Using the Report Editor
The Column Detail Zoom
Modifying Report Blocks
Using the Report Runner
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Using the Report Editor

3-2

The Edit the Report option from the Report pull-down menu allows
you to make changes directly to the report template generated by the
automatic column formatter. Once you modify your report using the
Edit the Report option, you lose the ability to make changes using the
pull-down menus.

[ESC] Save [DEL] Cancel “[" New Column “{" New Group
Report Name: Orders

1.1 (Zoom)=
10 20 30 40 50 60 70
........................ [ut'.le.]Pa
aOrder Date Item No Description Price Qty Extension
3L 10__3¢C ]
1

15 -

In the Report Editor, you have four options displayed at the top of the
screen:

e [ESC] saves your report

e [DEL] returns you to the pull-down menu
¢ “[” allows you to add a column

¢ “{” allows you to add new groups of data.

You can also scroll up and down and to the left and right using the
arrow keys. Rulers along the top and left edges of the report indicate
the column and line numbers. Toward the upper right-hand corner
on the double dotted line, the cursor location is displayed in paren-
theses. For example, as displayed in the example above, (1, 1) means
that the cursor is located at line 1 and column 1.

Editing Reports
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Editing the Report Template

Once you are in the Report Editor, you can add, delete, or change col-
umns, groups, and text by typing in the report template. The follow-

ing Informix-defined editing keys are also available to use while

editing your report.
Key(s) Action

[CTRL]}-[a] insert space
[CTRL}-x] delete character
[CTRL}-[d] deletes to end of line
{CTRL]-{p] pastes a line
[CTRL]-{u] undo an edit
[F1] insert a blank line
[F2] delete a line
[ define a new column group
{ define a new group
[ESC] save
[DEL] cancel

You can also cut and paste a line in the report by selecting [F2] to

delete a line, which actually puts it to a temporary buffer. Then paste
the line by pressing [CTRL]}-{p].

Using the Report Editor
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Column Detail Zoom

34

The Column Detail Zoom can be accessed directly from the Report
Editor by pressing [CTRL]-[z]. When your cursor is placed on a col-
umn in the report template, (Zoom) appears in the upper right-hand
corner on the double dotted line, indicating that the Zoom option is
available for accessing the Column Detail Zoom screen.

LESC] Save {Dell Cancel CCTRLI-Tw] Help
Column Detail Zoom

Column Nawe : o RIIIIgReEIT

Order Date
Format : left
Hidden? N
Table Name : Sales Orders

orders
Report Block : Report Body
Column Type : column
Position Row : S Coluen : 2 Length : 8

Enter a unique name for this column.

The first portion of the screen contains detailed information about the
column:

¢ Column Name displays the Informix table name and column
name on the first line and the familiar name on the second line.

* Format allows you to define the column justification or numerical
formatting.

e Hidden? allows you to mark “Y” or “N” to print or hide a col-
umn.

¢ Table Name displays first the Report Writer descriptive name,
and below it the Informix table name.

* Report Block displays where this column is in the report block
definition. This is not an entry field. It is governed by the location
of your new column and where you pressed “ [“.

* Column Type displays the type of column. Column types are
Database, Subtotaled, Grand Total, Math Formula, Constant
Value, Runtime Report Value, and Hidden.

Editing Reports
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* Position Row/Column/Length gives the physical location and
size of the column as it appears on the report.

The bottom portion of the screen displays the math formula if the col-
umn is a formula column. To edit an existing math formula, press
[CTRL]-[z].

Adding a New Column

To add a new column press “[”, which brings up the Choose a Col-
umn Type menu. You will be prompted to select a column type.

[ENTER] Select [DEL3J Exit

Choose a column type

latabase Column
Subtotaled Value
Grand Total Value

Math Formula
Constant Value

Runtime Report Value

Hidden tolu-ns

There are several different types of columns including the following:

¢ Database Column displays a list of columns in the main data-
base. Zoom is available to list the columns in related tables. If a
column is selected, you will be prompted with the Column Detail
Zoom to make any changes to the column detail information.

¢ Subtotaled Value and Grand Total Value are columns that can be
added to the report when you have added report groups through
the Report Editor.

¢ Math Formula lets you add a field to the screen to display the
value of a math formula.

¢ Constant Value allows you to define a constant value to be dis-
played in that column.
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* Runtime Report Value allows you to place special values on the
report that are specific to the time the report is printed. These spe-
cial values include system-generated page number, time and date
stamping, etc.

* Hidden Columns displays a list of all columns marked to not dis-
play on the report.

Once the column type is selected and the column detail is saved, the
column is activated on the report.

Creating “Hidden” Columns

The Report Editor allows you to hide a column that you do not want
to print on your report. This is commonly used in creating math for-
mulas with column values you do not want displayed on the report.

To hide a column:

1. Place the cursor on the column.

2. Press [CTRL]-[z] to modify the column detail.
3. Enter “Y” in the Hidden? field.

4. Press [ESC] to save.

Once you have saved the column detail information, the column is
removed from the Report Editor screen.

To list all hidden columns on your report:
ll[’l

1. Press “]” to display the Choose a Column Type menu.

2. Press “H” to display a list of all hidden columns on your repott.
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If you wish to reveal a column that has been hidden on your report or
to modify the hidden column detait:

1.
2.

List all hidden columns on your report.

Select the column from the window of the column you wish to
reveal.

The Column Detail Zoom appears for you to change the Hid-
den? field to “N.”

Press [ESC] to return to the Report Editor and view the column.

Math Calculations

The Report Writer allows you to create math columns. You must be in
the Report Editor to define math formulas.

To create math formulas:

1.
2.
3.

Press “I” to add a new column.
Select Math Formula from the menu.
Enter the math formula in the scrolling window.

Columns that are available to perform calculations within the
report block will be listed in a window below the main formula
window. The columns available to be used in the math formula
are numeric columns in that Report Block only.

Once the math formula is saved, the Column Detail Zoom screen
appears for you to define the numeric format of the new math
column.

To edit an existing math formula:

1.
2.

Press [CTRL]-{z] to display the math column detail.

Press [ENTER] to move to and highlight the block at the bottom
of the window.

Press [CTRL]-[z] to display the scrolling math formula defini-
tion window.

Edit the math formula.
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If you want to use a subtotal, grand total, or math formula amounts
in your math formula, you must place the new math formula after
(either to the right on the same row or on a row below) the calculated
value. The Report Writer reads values from left to right. For a calcu-
lated value to be included in a formula, its value must first be calcu-
lated.

Formatting Data in the Column

3-8

The text justification or numbered formatting can be defined in the
Column Detail Zoom screen in the Format field.

Justification choices include the following:

e right moves the text to the right edge of the column display.
e center centers the text within the column.

e left moves the text to the left edge of the column display.

¢ pushleft moves the data in the field to the left and inserts a lead-
ing space. This is helpful when making address labels. It leaves
only one space between the city and the state even though the
length of the city columnn varies.

¢ flushleft moves the data in the column to the left leaving no
spaces between columns. This is useful when two columns are
displayed as one item with no spaces between them.

¢ flushright moves the data in the column to the right leaving no
spaces between columns. This is useful when two columns are
displayed as one item with no spaces between them.

Numeric formatting choices include any Informix numeric format for
formatting numeric data. Refer to the Informix Reference Manual for
more information on numeric formats. Examples appear below.

*  $$5,555.5%
o I IR

<< <<
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Runtime Report Values

Runtime report values are special column types that display system
defined values at the time the report is printed. You can specify the
location of these columns on your report when you add the column.

To add a runtime report value:

1.
2.
3.

Move the cursor to where you want to add the column.

Press “[” to display the Select Column Type window.

Select Runtime Report Values. The available columns or values
you can add include the following:

[ENTER] Select [DEL] Exit

Choose a report value

Time of Printing
Date of Printing
Report Title
Selection Set Name
Report User Name
Row Count

Rou Number

Page Number prints the page number on the report. It only
prints the number; if you want “Page 2" printed you must add
“Page” before the special column in the Report Editor.

Time of Printing prints the time the report was printed.

Date of Printing prints the day the report was printed according
to the Informix DBDATE definitions variable.

Report Title displays the name of the report file on the report.
Selection Set Name prints the name of the chosen selection set.
Report User Name prints the login name of the report author.

Row Count counts the total number of rows within the report.
This does not count rows broken down by subgroups.

Row Number assigns a number to the current row of the report.
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Report Blocks

The Report Writer places block tags on the left edge of the Report Edi-
tor to identify the roles that particular blocks of text play in the
report. The block tags are generated automatically based on the
report definitions. The blocks can be modified using the Report Editor.
You can insert or delete rows and add new report blocks.

standard: Report  Delete  Options  Help  Quit
Load. save, and print reports

30 40 50 60 70

Order Date Item No Description Price Qty Extension

it 1t 1L

If the columns in the report extend beyond the width of the report
format, the columns are automatically stacked rather than displayed
across the report. The following report shows stacked columns and
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provides a better illustration of the relation of the report block tags
and the corresponding columns and column groupings than the
screen above.

[ESC] Save [DEL] Cancel
Report Name: Orders

“L” New Column “{" New Group

GO

¥ Order No: [__ ]

Order Date
Item No | —
Description [
Price L
Qty r
Extension [
Ship Date [______3
4
L
[

]

-

1

1
]

Pay Date 3
GE Subtotals for T________ ]
Extension

———_1

]
]

Extension [

Type of Report Blocks

FR is the First Row Block Tag. This report block will print once at
the very beginning of the report.

HD is the Header Block Tag. The header information is printed
once at the top of every page of the report.

B1, B2... are Before Block Tags. The Before block tags identify
blocks of text which are printed on the report before the detailed
data rows. Examples of before blocks of data are Grouped infor-
mation. In the example above there is a Bl and a B2.

B1, or Before 1, indicates the block of information will print
before the group by Company Name information. B2, or Before
2, identifies a subgrouping of information based upon a group
definition by the column Order No. Before groupings are num-
bered according to the sequence specified in the Group and Sort
definition. These are group headings, which will print at the
beginning of each group break.
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Blank Tag The row directly following the Before Tag which has
no identifier identifies where the report detail data rows will
print.

A2, Al... are After Block Tags. The After block tag identifies infor-
mation that is printed after the report detail data rows. Subtotal
groupings are numbered according to the corresponding Before
block tag. The sequencing is relative to the sequence defined in
the Group and Sort definition.

LR is the Last Row Block Tag. It is printed on the final row of the
report. It contains column information such as Grand Totals.

TR is the Trailer Block Tag. It is printed at the bottom of every
page and can be defined to contain footer information.

Note

When defining a math formula, the columns that can be used in the
formula are displayed in a window below the formula entry field.
The columns that are available are numeric columns located in that
Report Block.

Adding a New Report Block

The steps to adding a Report Block to your report are dependent
upon the type of report block you are adding. In the Report Editor you
can add the following types of report blocks:

3-12

B# or Before Group
A# or After Group
LR or Last Group
TR or Trailer
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The type of block you can add is sensitive to the line the cursor is on
in relation to the existing report blocks and predefined report groups.
If you are not on a row to which a report block can be added, you will
get the following message:

You cannot start a new report block from your
current position in the editor. First move
your cursor to the line just above where the
new report block should be and then press “{".

Adding a Before or After Group Report Block

Once you make changes to your report in the Report Editor, the auto-
matic column formatter no longer updates the report template. Any
additional data groupings defined in the Group and Sort will not
appear on the report; adding new groups must be done through the
Report Editor.

The steps for adding a new B or A group are as follows:
1. Select Group and Sort from the Report ring menu option.
2. Enter and save the column grouping information.

When a new report group is defined there are two types of report
blocks that can be added to the report, a Before Group or an After
Group. The number associated with the B or A block tag will be
dependent upon the grouping sequence defined for the column.
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Since Before and After Blocks refer to a specific Group, the refer-
ence is Group specific. The following template and sequence def-
inition displays one block:

Sort the Report by these Columns
LESC] to Store EDEL] to Cancel

~ Seq ~ Sort? - Group? - Page Bk.- Column
Y N Customer Number

Enter order of the column for sorting.

The Customer Number field defines the only grouping, and can have
items placed before (B1) or after (A1) the area where the data repre-
senting one customer number is presented.

standard: File Delete Options Help Quit
Build and wodify a report

Editing Reports
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The following report template has more than one group defined:

Sort the Report by these Columns
[ESC] to Store LDEL] to Cancel

- Seq - Sort? - Group? - Page Bk.- Columen

1] Y N Customer Number
2 A Y N Order Number
3 N N Jtem Number

Enter order of the column for sorting.

Even though there are three fields in the Sort consideration, only two
are specified to have data grouped. This instructs the Report Writer to
create blocks for each, B1, B2, Al, and A2:

standard: File Delete  Options Help Quit
Build and modify a report
10 20 30 40 50 60 70
[date ] ............... [u.tle ......... R SR ireeeieeesieees o
(3iCust No: [_ ]
Order No: [ -
Order Date Item No Description Price Qty Extension
C 1 .31t 1L B S B S
Subtotals for [________ ] —mmmmm e
C il
EiSubtotals for [ ettt
4 3
1588Grand Totals ———————— e
C il

The Order Number Block (the second group) can have other informa-
tion placed before it (between B1 and B2) and after it (between A2
and Al).

The Customer Number Block (first group) can have information
before (between HD and B1) and after it (between Al and LR).
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In order to add information to a report template:

1.
2.

Select Edit the Report from the Report ring menu option.

Place your cursor on the row above where you wish to insert
the group.

Press “{”. A window appears with the report blocks that are
available to add to the screen.

Once the report block is added, you will have a blank row to
add further text and column information.

Adding Last Groups and Trailers
The steps for adding LR or TR groups are as follows:

3-16

1.

AT T

Place the cursor on the line above where you wish to add the
new LR or TR group.

Press “{".
Confirm you wish to add the report block.
A new line is created for the new report block.

Add text or columns on that line.
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The Report Runner

The Report Runner allows you to print, from a UNIX prompt, reports
created with the Report Writer. This shortcut eliminates the need to
execute the Report Writer program for the sole purpose of printing,
thus saving time. By using the Report Runner, the first request for
input is at the Choose a (print) Destination window.

In order to run reports with the Report Runner, you must know the
name of the report and the name of the database. If you are going to
print the report with a selection set, you must know the name of that
selection set.

To print a report using the Report Runner the syntax is:

fg.runner -d database -r report _name -s
selection_set_name

To print a report using the “stores” database called “Orders” with the
selection set “Unpaid Orders” you would type:

fg.runner -d stores -r Orders -s "Unpaid Orders"

Note

To specify a report or selection set that has more than one word, you
must put quotes around the report or selection set’s name.

Once you enter the £g. runner command, the Choose a Destination
menu appears

CENTER] Select [DEL] Exit

Choose a Destination

lisplay to Screen

Output to Printer
Write to File
firchive to Database

Export Data >>
Reporting Options >>
Quit
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From this window, the Reporting Options selection lets you further
define your reporting options.

If you make an error typing the name of the database, report, or selec-
tion set, the Report Runner will display an error message notifying
you which part of the statement it was not able to understand.

The following report does not exist:

Report Name: Orderz
Database Name: standard
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Section Summary

The Report Editor allows you to make modifications directly to
the report template displayed on the screen. Once you edit your
report in the Report Editor, the Report Writer will not automati-
cally format the report template.

Column detail information is accessed by editing within the
Report Editor, allowing you to change the column format, hide
columns, and perform math calculations on column values.

Report Blocks are tags located along the left edge of the Report
Editor screen which identify the role of a group of lines within a
report.

New Report Groups can be added within the Report Editor only
after they have been defined in the Group and Sort window.

The Report Runner allows you to print a report any time, any-
where, from a UNIX prompt, if you know the names of the data-
base, report, and optional Selection Set.
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Lab Exercise 3a

Objective: To add columns to the report from the Report Editor.

Adding Columns in the Report Editor

1. Load the Customer Orders Summary report.
2. From the Report pull-down menu, select Edit the Report.

3. Using the edit keys, add the following columns below the Cus-
tomer Number column:
Company Name
Address
City, State, Zip
Contact Name (first and last)
Phone Number

4. Add them to report Block 1 and format the fields to “pushleft.”

[ESC] Save [DEL] Cancel “[” New Column “{" New Group
Report Name: Orders
a.n (Zoow)=
10 20 30 40 50 60 70
.................... [t._;tie.“ [ P S ...i-....-....-....l;;.
Contact Name:[ i 3
Phone :L 1

5. Display the report to the screen.
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Lab Exercise 3b

Objective: To use math columns to calculate the order sales tax and to
create a new column called Order Total.

Math Formulas

1. Load the Customer Orders Summary report and, from the
Report pull-down menu, select Edit the Report.

2. Insert three rows to the bottom of Report Block A2.

3. On the line directly below the orders subtotal amount, insert a
row of “----" to create a line across the report.

Refer to the report image at the bottom of the page.

4. On the row below the line, add the text “Shipping Charge” and
add the database column Shipping Charge to the report.

5. Next to the Shipping Charge column add the text “Sales Tax”
and press “[” to add a new column to the report.

6. Select Math Formula from the column type window and entera
math formula to calculate 8.2% sales tax on the order subtotal.

The formula to make this calculation is (.082 * Al).

Note

On your report, the variable for the subtotal of items.total_price may
be different than Al. If it is, use the variable displayed in the
variables window that identifies SUBT_AF_2 _items.total_price.

7. Enter a numeric format of $$$.$$ for this math column and
reduce the field size to six characters using the [CTRL}-[x] key
combination.

8. To the right of the sales tax column, add the text “Order Total”
and press “[” to add a new column to the report.
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9. Select Math Formula and enter a math formula to add the
Orders Subtotal, Shipping Charge, and Sales Tax. Reduce the
field size to nine positions.

Your report should appear as illustrated below:

Report Name: Orders

[ESC] Save [DEL] Cancel

“[" New Column

10 20 30 40 50

82"6;3;;.ﬁ;;'f ........ i .......................... R ERR,

Order Date Item No Description Price Qty Extension

s 1 1 it I it 1t 1

Subtotals for [ I e

[ .l

GRShip Charge ( 3 Sales Tax [ ] Order Total [ ]

tMSubtotals for [ 1

€ ]

@®Grand Totals e

[ ]
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Lab Exercise 3¢

Objective: To add a new report group to the Customer Orders Sum-
mary report without using the Report Writer to automatically format
the report template.

Define Groups in the Report Editor

1.
2.

Load the Customer Orders Summary report.
From the Report pull-down menu select Group and Sort.

Before you can add a new group in the Report Editor, you must
first define it in the Group and Sort window from the Report
pull-down menu.

Change Item Number to Group as well as Sort.
Select Edit the Report.

Move to the last row of the Report Biock B2 and press “{” to add
a new group.

Add two columns in the new B3 report block to display the
Stock # and Manufacturer’s Code (located in the “Line Items”
Data File).

Print the Customer Orders Summary report.
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Lab Exercise 3d

Objective: To print the Customer Orders Summary report from a
UNIX prompt with the Unpaid Orders selection set.

Report Runner

1. From a UNIX prompt, enter the command to print the Customer
Orders Summary report using the Unpaid Orders selection set.

2. Display the report to the screen.

3. Without exiting back to a UNIX prompt, reprint the report with
no selection set. »

4. From the Reporting Options choose Data Selection.

5. Modify an existing selection set to contain no selection criteria
and save it upon exiting as “No Selection Set.”

6. Display the new report to the screen.

3-24
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Major topics in this chapter include the following:
B Naming Tables and Columns ‘
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Descriptive Table and Column Names

42

You have the ability to give familiar names to the tables you create.
Tables and columns created in INFORMIX-SQL (ISQL) are assigned
default names which are often not descriptive enough for your users.

The Table/Columns option on the Options pull-down menu allows
you to give tables and columns more descriptive or familiar names.
Here, a table called “paymeth” is being assigned a familiar name.
Each of its columns may also be assigned more descriptive names:

Columns in the Table
LTAB] to Table Window [ESC3 to Save [DEL] to Cancel £CTRLI-Lw] Help

- Column --—-——----- Column Name ——=—~===—m—cec—ca—- Column Label -——————
pay_code Payment Code

pay_desc Pai-ent Code Description Payment Type

Enter a familiar name for the column.

“Column Label” is the heading for the column as it appears on a
report. The Column Name will appear as the default column heading
if the Column Label field is blank. Column labels can be changed for
individual reports within the Report Editor.
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Data Groups

The Data Groups option on the Options pull-down menu allows you
to put tables into a data group, or to create new data groups. Both
Table Description and Table Name are Zoom-capable fields. Here is
an example of the “paymeth” table being added to the “Demo Data
Set:”

Update: L[ESC] to Store. L[DELJ to Cancel
Enter changes into form

Define Data Groups

Group Name: DETIPEREIE

- Table DBescription —--—-—-==~--- Table Name ————~~-~
Customer Information customer

Sales Orders orders

Order Line Items iteas

Inventory Items stock

Manufacturer Definitions manufact

State Definitions state

Credit Information credit

Enter the name of this data set.
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Table Relationships

4-4

After a data group has been added, you should define how the new
table relates to the other tables in the database, so that the Report
Writer knows how to incorporate this new table, and what the join
column(s) are. The Table Relationships option on the Options pull-
down menu allows you to establish this relationship to the other
tables in your database. Here is an example of how the customer table
relates to the orders table:

Update: [ESC] to Store. [DEL] to Cancel
Enter changes into fors

From Table:

to Table: state

Relationship Type: 1

Enter the main table for the relationship.

~-- From Column ——————-——- To Column ~————wm—-m-m
state code
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One-t0-One Relationships

In a relational database, there are various ways that tables relate to
each other. In the one-to-one relationship illustrated below, each
order can have only one payment method attached to it. Therefore, a
one-to-one relationship exists between the customer table and the
state table.

customer
state

The relationship is specified as 1-1 in the Relationship Type field of
the Define the Table Relationship window. The join column(s) are also
specified in the Define the Table Relationship window.

One-to-Many Relationships

Another way that tables relate to each other is the one-to-many rela-
tionship.
One payment method can appear on several orders. Therefore, a one-

to-many relationship exists between the customer table and the
orders table.

customer
orders
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This relationship is specified as “1-many” in the Relationship Type
field of the Define the Table Relationship window. The filled-in
Define the Table Relationship window would appear as follows:

Update: [ESC] to Store. LDEL] to Cancel
Enter changes into form

--——--- Define the Table Relationship —--~———-

From Table: customer
to Table: orders

Relationship Type: B

1.71-17: 2.71-wany™: 3.71-0/1": 4.71-0/many”

-- From Column ———————-- To Column --—-——-~v—-
customer_num customer_num

Notice the join column(s) are specified in the bottom portion of the
Define the Table Relationship window.

Outer Joins

4-6

The purpose of defining table relationships is to present the data on a
report correctly. The Report Writer will take into account how tables
relate to each other at the time the report is printed. If table relation-
ships are improperly defined, the data on the report will not be cor-
rect.

For “1-1” and “1-many” relationships, data will appear on the report
only if a value exists in the join column of the table listed in the to
Table field in the Define the Table Relationships window. If the join
column’s value is null, nothing will appear on the report.

Outer joins placed on a table relationship allow you to see all data on
a report regardless of whether values in the join columns of the table
listed in the to Table field are null or not. You specify outer joins with
“1-0/1” or “1-0/many” in the Relationship Type field of the Define
the Table Relationships window.

Managing the Data Dictionary
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Section Summary

B Each table added to a database can be given a descriptive name.
A descriptive name is familiar to the user of the table. Likewise,
each column can have a familiar name.

B Each new table should be added to a data group.

B Each table’s relationship to other tables in the database must be
known to the Report Writer. Types of relationships are “1-1,” “1-
many,” “1-0/1,” and “1-0/many.”

B Outer join relationships display all data on a report regardless of
whether there is a match in the join columns.
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Lab Exercise 4a

Objective: To introduce a new table to the Report Writer. The table will
hold credit code information, and each customer will have an indi-
vidual credit code. Give this table a familiar name, include it in a data
group, and establish its relationship with the customer table.

Adding the Table Through 1SQL

1. Add a table called credit to your stores{} database.

4-8

(If you already have this table, you may proceed to Exercise 4b).
Use ISQL to add your “credit” table. The “credit” table will hold
the following columns:

Column Name
credit_code
credit_desc

credit_amt

Type

char(3)
char(10)
decimal(10,2)

2. Once the table has been created, add the following rows to your
“credit” table with ISQL.:

credit_code credit_desc credit_amt
AAA Excellent $10,000
BBB Good $5,000
cccC Fair $1,000
DDD Poor $250

Managing the Data Dictionary
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Give Your Tables Descriptive Names

Next you can give your tables familiar names so that your users do
not have to remember technical names.

1.

Start the Report Writer with:

fg.writer -d stores{}

Select Table/Columns from the Options pull-down menu and
pull up your credit table.

On the window that comes up, assign a familiar name to your
credit table, such a Credit Code Information.

Give each column a descriptive, familiar name, if names have
not been assigned yet.

Press [ESC] to save your work in this window.
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Lab Exercise 4b

Next you will add your new “credit” table to the “Demo Data Set”
data group.

Adding Your New Table to a Data Group

1. Select Data Groups from the Options pull-down menu. Select
the “Demo Data Set” data group.

2. Under Table Description or Table Name, enter either the famil-
iar name or technical name of your credit table. You may use
the Zoom feature to help you.

Note If you enter the familiar name, the technical name is looked up for
you after you press [ENTER]. If you enter the technical name, the
familiar name is looked up for you after you press [ENTER].

3. Press [ESC] when done.
4. Exit the Report Writer.

Adding a Column to the Customer Table

Each customer can have one credit code. Therefore, you will add a
column to the customer table to hold a particular customer’s credit
code. (If your customer table already has this column, you may pro-
ceed to “Adding the Table Relationship,” below.)

1. Using ISQL, add a Credit Code column to the customer table.

Make sure the Credit Code column is the same name and type as
the Credit Code column in your credit table.

2. InISQL, enter some credit codes for some of the customers.

Be sure the credit code values are the same as the values for credit
code in the credit table.

3. Exit ISQL.
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Adding the Table Relationship

Next you will make known to the Report Writer how the credit
table relates to other tables in the stores{} database.

1.

Start the Report Writer:
fg.writer -4 stores{}
Select Relationships from the Options pull-down menu.

Select Add a New Relationship at the Choose a Table Relation-
ship window.

Enter “customer” in the From Table field of the Define the Table
Relationship window.

Enter “credit” in the to Table field. Then determine the relation-
ship type that exists between these two tables.

Ask yourself, how many credit codes can one customer have? For
example, you can have many orders for one customer. Therefore,
you would enter a “2” in the Relationship Type field for the
“customer” - “orders” relationship. “2” is a “1-many” rela-
tionship.

Tab to the From Column - To Column area, and enter the join
information.

Both fields are Zoom capable.
Press [ESC] to save your work.

Again, select Add a New Relationship at the Choose a Table
Relationship window and define the relationship in reverse for
the two tables.

Press [ESC] to save your work.
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Add Credit Information to Your “Customer Orders
Summary” Report

Finally you will see your new table and relationship in action. Add a
credit description field to your “Customer Orders Summary” report.

1. Inthe Report Writer, load the “Customer Orders Summary”
report.

2. Select Edit the Report from the Report pull-down menu.

3. Add a credit description field label (and the field) to the report
in the B1 block.

4. Save and print your report with no selection set.

Using an Outer Join

If the relationship types you chose were “1-1” or “1-many,” you will
only see those customers that have credit codes in the database. The
customers that do not have credit codes are not on the report.

If you would like to see all customers regardless of the existence of a
credit code, change the relationship types to “1-0/1” or “1-0/many.”
This is how you indicate that there is an outer join relationship
between tables.

1. In the Report Writer, select Relationships from the Options
pull-down menu.

2. Change the two relationships you entered above to indicate
“1/0-1” or “1/0-many” for their respective relationship types.

3. Re-print the report.

What prints now?
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Report Code Generator Overview

SPECIFICATION FILES
REPORT CODE
eport if GENERATOR
fg.report
GENERATED -
/\ SOURCE CODE
REPORT OBJECT CODE
WRITER
fg.wr:.te EXECUTABLE
CODE

[ DATABASE
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Sample report.ifg File

database standard

output
top margin S
bottom margin 5
left margin 5
right margin 75
page length 66
page header
{
<a0 ] +Al ]

Page: [AZ2 ]

Cust No: [A3 (a4

Order No. Date Item No. Price Qty Extension
}
on every row
{

[a6 1 A7 ] (a8 ] {AA ] [AB ] [AC I
}
after group of orders.customer_num
{

[AE 1

on last row
{

Grand Totals

Extension [AF ]

}

attributes
A0 = today
Al = constant “Orders Listing”
A2 = pageno using “<<<<<®
A3 = orders.customer_num using “<<<<<<<<<<<™
A4 = customer.company
AS = customer.zipcode
A6 = orders.order_num

Sample report.ifg File 5-3
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5-4

A7 =

EREE S

AE =

end

select
name
tables
join

items.manu_

orders.order_date

stock.stock_num

stock.unit_price

items.quantity

items.total_price

orders.customer_num using “<<<<<<<<<<<®
sum({items.total_price)
sum(items.total_price)

= orders, items, stock, customer
= customer.customer_num = orders.customer_num and stock.manu_code =
code and stock.stock_num = items.stock_num and items.order_num = orde

rs.order_num

order = orders.customer_num
end
defaults
progname = report
prcname = Orders Listing
destin = report.out
end

data group
tbls
lang
end

Demo Data Set
= customer orders items stock manufact state credit
= ENG

Report Code Generator
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Files Generated by the Report Code
Generator

The Report Code Generator creates the following files:

globals.4gl main.4gl
midlevel.d4gl lowlevel .4gl
report.dgl Makefile

A Makefile is simply a list of files to compile and libraries to link.
FourGen uses the UNIX make utility to compile files.

The report. 4gl takes the WYSIWYG image in the report.ifg
file and maps it out as follows.

Compiling Programs

The generated 4GL source code must then be compiled into object
code. Also, all calis to functions in libraries must be resolved. Report
programs are compiled with a script called fg.make. The £g.make
script will compile each .4gl file and link in library functions that are
called within the generated code.

Passing Criteria at Run-Time

Once you have compiled a report program, you can pass criteria to
the report on the UNIX command line.

The filter flag passes an SQL “where” clause. For example:
fglgo *.4gi -d standard filter “*strtranr.doc_date > 01/01/92"

The order flag passes an SQL “order” clause. For example:
fglgo *.4gi -d standard order "strtranr.doc_date"

Most of the other variables in the “defaults” section of a report .ifg
file can be overridden at run-time. Another often-used variable is
destin. This variable is used to specify the report’s destination at
run-time (e.g., screen, file, or printer).

Files Generated by the Report Code Generator 5-5
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Report Data Flow
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Report Functions

The following tables describe some of the key functions used by gen-
erated report programs.

Initialization Functions:

ct_defaults()
ml_defaults()

ct_parse()

ct_display ()

ct_display()
ml_getcount()

ct_display()

ml_define_cur()

ct_start_xrpt()
ct_display()
ml_fetch()
ml_curs_prep()

before_group ()

ml_curs_null()

injtialize all “ct” global variables with
hardcoded default values

initialize “ct” variables with values from the
report.ifg file

reads command line input from report, if any

border info for pre-report screen called with
seven different flags

Gathering elements message

number of records fitting selection criteria;
terminates if no rows

Sorting ## Elements message

run select statement with all elements
required to load cursor

destination output initialize

“Processing element # of #” message

get first row of cursor into curs_next record
put data into curs record from curs_next

“first row” initialization of report break logic;
additional code can be added

clears curs buffer; curs_next record
contains first row; curs buffer is null

Report Functions 5-7
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Loop on Detail Functions

check to see if curs = curs_next; if false
ml_before_break() then thereis abreak; break logic is also done
by “Report;” custom code can be added

here
ml_curs_prep() curs_next row moves to curs record
ml_fetch() if not last row, get next row into

curs_next record
on_every row() moves curs data into report record
ml_after_break() check to see if group finished
after_group() last row of table processing

ml_output () report line is output to “Report;” “Report”
is report name generated

ct_display () “Processing # of #” message

End of Job Functions:

ct_f£finish() “Finish Report” message
ct_display() “Processing Complete” message

clear_screen() clears the screen display

Report Functions Commonly Modified

5-8

There are some functions in midlevel. 4gl that you will frequently
modify. These functions give you control over the SQL statement that
is executed to return rows from the disk. You can modify these func-
tions to pass criteria to the SQL statement:

e ml_filter():manages the final “where” criteria that are used
in the SQL statement. Theml_filtexr () function manages the
ct.sel_£filter variable, and is typically modified to pass

Report Code Generator
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selection criteria to a program. An example of how you can mod-
ify ml_filter() to put a selection criteria screen into a modi-
fied program is included in this section’s Lab exercises.

* ml_order ():manages the “order” criteria that are used in the
final SQL statement. It manages the ct . sel_order variable.

¢ ml_join(): manages the “join” criteria that are used in the SQL
statement. It manages the ct . sel_join variable.

Referencing Fields not Printed in the Report

On occasion, you need to select data to be included on a report, or
“order” report output based on a field that does not appear on the
report. The optional more line defines the columns that are not
included on the report but are needed in the select or order by state-
ments.

If the report from the previously mentioned sample report.ifg
file needed to be arranged by active code, payment method, or
another field that does not print, a modification to the select section of
the .ifg file would allow that functionality. As the following example
illustrates, each field to be included is defined with its own more
statement.

select

more = customer.paymeth

more = customer.active

name =

tables = orders, customer

join = customer.customer_num = orders.customer_num
order = orders.customer_num

Report Functions 5-9
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Basic Library Philosophy

A library holds source code that is shared by other programs. Envi-
sion several lines of source code that check the form to be printed to,
lines per page, carriage control, etc. Every print program will use this
source code. Does it make any sense to copy the same lines of source
code into every program directory that uses these lines of code? No.
Therefore, the lines of source code are placed into a function, and that
function is placed into a library. Any program that needs to consider
these options simply calls that function in the library.

When placing a function that will be shared by programs into a
library, we first ask:

e What types of programs will use this library function?
¢ Will it be used only by report programs?

¢ Will it be used by products other than report programs, such as
input programs?

Based on what types of programs will use the function,
places it into an appropriate library directory.

libraries exist as library directories. A library directory is
simply a .4gs directory that contains .4gl files with code shared by
multiple programs.

5-10 Report Code Generator
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Directory Structure

Program Directories contain all the files that make up a program.
Program directories are the lowest level of directories.

Module Directories contain program directories. A “module”
contains a group of programs that are somehow alike.

Application Directories contain module directories. An “appli-
cation” contains modules that are alike.

APPLICATION|

MODULE A MODULE B MODULE C

| |

PROGRAM 1 PROGRAM 2 PROGRAM 3

Directory Structure 5-11
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Section Summary

5-12

You have the ability to create INFORMIX-4GL source code on
reports that you develop with the Report Writer. One advantage
of creating code is that you can modify the code; that is, any capa-
bilities that cannot be performed with the Report Writer may be
coded into INFORMIX~4GL source code.

Export a report specification file called report.ifg. The
report.ifg file is read by the Report Code Generator, and
INFORMIX-4GL source code is created based on instructions in
the report.ifg file.

Two special files created by the Report Code Generator are
report.4gl and Makefile. The first, report . 4gl, is the
WYSIWYG image of the report in the report . ifg file mapped
out in INFORMIX-4GL language. The Makefile contains a list
of files to compile and libraries to link.

The source code is compiled with fg.make script.
Compiling converts each source code file into object code. The
fg . make utility also performs linking, which means that calls to
library functions in the generated source code are resolved. The
script £g . make uses the UNIX make utility to perform its tasks.

You can pass report criteria from the command line.

Fields used to select or order report output, that are not included
on the report, are declared by adding a more statement in the
select section of the report . ifg file.

The flow of a generated report is very simple. The first half of the
logic handles setting up the main SQL statement and executing it.
The second half of the logic handles processing each row
returned by the SQL statement.

Commonly modified functions areml_filter, ml_order, and
ml_join. These functions control the final filter, order, and join
criteria, respectively, that are attached to the main SQL statement.

When creating a directory to hold an exported report .ifg file,
the same directory structure that is followed with input and edit
programs applies to report programs.

Report Code Generator
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Lab Exercise 5a

Objective: You will create INFORMIX-4GL source code for a report
you made in the Report Writer.

Make a Simple Report

First, you will make a simplified “customer orders” report. It is help-
ful to work with a simplified report when learning how to modify the
code.

1.

SR S

Start the Report Writer with

fg.writer -d stores{}

Load the “Orders” report.

Under the Report pull-down menu select Group and Sort.
Group the “Orders” report by Customer Number.

Save as “Orders Listing.”

Quit out of the Report Writer.

Export the Report from the Report Writer

1.

From your HOME directory, make a directory called
“labs.4gm.”

cd to $SHOME/labs .4gm
Make a directory to contain the report program.

Give it an o_ prefix and name it with your initials or student
number. Examples:

o_wjc.4gs, o_stull.4gs, o_rep0l.4gs

cd to your newly created directory.
Start the Report Writer

Load your “Orders Listing” report.

Lab Exercise 5a 5-13
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9.

Under the File pull-down menu, select Import/Export and then
select Export Report.

You import and export reports for two purposes: To move reports
from one database to another and to generate code from a report
in the Writer. In this exercise, you will generate code from the
“Orders Listing” report.

Under “Export File Name,” change report.txt to
report.ifg.

Press [ESC] to export the report.

10. Exit the Report Writer when finished.

Generate Code on the Report

5-14

1.

List the files in your report directory. Notice the report.ifg
file.

The report.ifg file alone will not make up an entire report. It
is simply a specification file. You must create and compile source
code to run your program. The Report Code Generator will do
this for you.

Start the Report Code Generator with the following command:
fg.report -d stores{}

The Report Code Generator reads the instructions in the
report.ifg file and creates INFORMIX-4GL source code. This
source code is the code that will drive your report.

When the Report Code Generator is done, list the files in the
directory.

The newly-created .4gl files contain INFORMIX-4GL source code.

Report Code Generator
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Compile the Code

After generating code, you must convert this code to object code, and
then link in the libraries. These processes are called “compiling” and
“linking,” and you use the following steps:

1. From your report directory, compile your code by typing
fg.make
2. When compiling and linking is done, list the files.

All the object code exists in either .4go files or .o files, depending
on whether you compiled using INFORMIX-RDS or INFORMIX-
4GL, respectively. The lone executable file has a .4gi or .4ge exten-
sion.

Run the Program

1. Run the program with the following command:
fglgo *.4gi ~4 stores{}
-or-
*.4ge -4 stores{}

After the report runs, the results are placed in a file called
report.out.

2. Use vito view the report.out.

This is your final report.
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Lab Exercise 5b

Objective: To add a new field using the Report Writer and to generate
code to see the result of adding a field.

Add the New Field with the Report Writer

1
2
3.
4

Start the Report Writer.
Load your “Orders Listing” report.
Under the Report pull-down menu, select Edit the Report.

Add the “Company Name” column to the right of the Customer
Number column.

Under the File pull-down menu, select Save the Report to save
your work.

Select Import/Export and then select Export Report.

In the Export File Name field, change report.txt to
report.ifg. Overwrite the existing report.ifg.

Press [ENTER] and [ESC] to export your report with the new
field on it.

Exit the Report Writer when finished.

Generate Code on the Report

5-16

1.

Use vi to edit the report.ifg file and see if you can spot the
changes.

Start the Report Code Generator.

Before the Report Code Generator is finished, the Overwrite
menu appears. When it appears, answer choice “3” for each file.

If the Report Code Generator finds a .4gl file that already exists
and its newly generated .4g] file is different from the existing .4gl
file, it will ask you what to do with the existing .4gl file.

Report Code Generator
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Generally you will answer choice “1” to overwrite the file. How-
ever, for this exercise you will be viewing the differences between
newly generated .4gl files and old .4¢l files. Choice “3” gives the
existing .4gl file an “.old” extension and generates a new .4gl file.
Your existing file is preserved in the .old file.

Compile the Code

The newly-generated .4gl files now must be compiled and linked.

Use the following command to compile and link your code:

fg.make

Run the Program

1.

Diff the Files

Run the program with the following commands:
fglgo *.4gi -d stores{}

-or-

*.4ge -d stores{}

The report will run and the results will be placed in a file called
report.out.

Use vi to view the report.out.
This is your final report. Is your new field there?

Quit out of report.out.

Now use the UNIX diff utility to see how adding a new field affected
the generated code.

1.
2,

List the files in the directory.

For each .4gl file in your directory, run the dif£ command
against the .old file.

The diff command syntax is:
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Qiff [first_filel [second file]l

For example, to see the differences between report.old and
report.4gl, you would use diff as follows:

diff report.old report.4gl

What is the difference between the old .4gl file and the newly
generated .4gl file?

5-18 Report Code Generator
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Using Blocks to Modify Generated Code
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Report Code Generator Overview

SPECIFICATION FILES
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A Function with Blocks

Every line of code created with the Report Code Generator is within a
block. Here is an example of blocks within a generated function:

SHEHSRRHERBHAR B LR BB H R HR R B AR H AR SRR B AR E AR SRR R AR R BB AR BRI R R RN
function ml_defaults()

BHERFHEHERE RSN R B HSHBHH AR AR R R R B R R H R R SR B U R R R R R R ER AR SR ERBE R R SR
# this function sets the ct.* record values

#

#_def_prcname - insert “prcname” code here
let ct.prcname = “test 27

#_def_destin - insert “destin” code here
let ct.destin = “report.out”

end function
# ml_defaults()

Block Command Examples

Block command syntax:

block_command [function_namel [block_ID]
Example 1:

after block ml_defaults def_destin

This block command places code after the def_destin block in the
ml_defaults function.

Example 2:
before block ml_defaults def_destin

This block command places code before the def_destin block in
the m1_defaults function.

Example 3:
replace block ml_defaults def_destin

This block command replaces the entire def_destin block in the
ml_defaults function.
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Where Do Block Commands Go?

Block commands for reports go into .ext files, which are specification
files where you place your block commands and the custom logic you
wish to add. The Featurizer then reads the .ext files and places your
logic into the source code. This allows you to make further modifica-
tions to your report . ifg file, such as added fields, etc., and regen-
erate without having to manually re-insert your custom logic.

The start file Command

Any block command placed in a .ext file must be under a start file
command. The start file command tells the Featurizer to which file to
apply the block command.

Here is the syntax of the start file command:

start file *"file_name"

For example, a block command to manipulate a block inmidlev-
el.4gl would be preceded by the following line: ’

start file "midlevel.4gl™"

Here is an example of start file with a block command under it. Note
that quotes are required around a file name.

start file "midlevel.4gl*
after block ml_defaults def_destin
for n = 1 to num_args{)
if arg_val(n) = "-e"
then
let check_post = "CHECK"
end if
if arg_val(n) = "-p"
then
let check_post = "POST"
end if
end for ;

You can have multiple start file commands in an .ext file. Here is an
.ext file with more than one start file command:
start file "globals.4gl-”
before block NUL define
check_post char(s) ;

start file “midlevel.d4gl”
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after block ml_defaults def_destin
for n = 1 to num_args()
if arg_val(n}) = “-e"
then
let check_post = “CHECK"
end if
if arg_val(n) = "-p"
then
let check_post = "POST"
end if
end for ;

The logic that you see here parses the UNIX command line when the
report is run and accepts additional arguments. These arguments
then set a variable.

Note

There are some reserved words for blocks. Since there are no
functions in globals. 4gl, the block command uses the reserved
word “NUL” in place of the function name.
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Extension Files

The logic within blocks may be specific to one feature. You may set
up one .ext file for each feature that you have. This allows you to
selectively plug and unplug features from the source code of a pro-

gram.

For example, a feature that parses the command line for additional
flags could go into a file named:

parse.ext

A feature that could put a selection criteria screen into a report could
go into a file called:

select.ext

You can have as many features as you want.

Feature Set Files

Feature set (base.set) files allow you to tell the Featurizer which fea-
tures to plug and unplug. The names of the features are simply the
prefixes of the .ext files.

Here is an example of an entire .set file:

parse - looks for added command line input
select - pulls up selection criteria screen

This .set file instructs the Featurizer to insert the custom logic found
in the parse. ext file and the select . ext file. The Featurizer reads
this .set file and plugs in the parse and select features.

The Featurizer only reads the first word on a line in a .sef file. Any-
thing following the first letter space on a line can be descriptive com-
ments, as in the above example.

Plugging in Features with a .set File

The Featurizer will, by default, find and read a .set file called
base.set.
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Section Summary

The Featurizer handles block merging. Use a block when making
a modification to report code.

Blocks can be manipulated with block commands. Block com-
mands go into .ext files.

The start file command applies blocks to a specified file.
Extension (*.ext) files are selectively merged into code.
You specify what .ext files merge into code via a .set file.

Feature set (base.set) files allow you to specify what .ext files get
merged into code.
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Lab Exercise 6a

Objective: To merge your own custom code into the generated code
with the Featurizer. The code that you will merge will simply display
a message logo to the user before the program runs.

Run the Program and View the Logo

6-8

The first thing a report program does is display a “Loading Program”
message to the screen. You will first see this message in action by run-
ning your report program.

1. Run the report program.
fglgo*.4gi -d stores
-or-

* _4ge -4 stores

You can place additional message information around your
“Loading Program” message. For instance, you might place a
copyright message here or list the programmers who created the
program.

2. Usevitoopenmain.4gl and find the function called logo.

This function is responsible for displaying a unique message to
the screen just before a report program runs. It displays the
“Loading Program” message, and is generated for every report
program.

FourGen'’s copyright message is set up to appear, but its display
statements are commented out.
3. Find the two blocks in logo.

Notice how each line of code with the 1ogo function is within a
block. The blocks are marked with block tags (they are preceded
by a u#‘—n .

The first block in this function displays the “Loading Program”
message to the screen.

Using the Featurizer
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This is the block that you will manipulate with the Featurizer to
display your own logo to the screen.

4. Quit out of main.4gl

Use the Featurizer to Place Custom Logic into Code

Next you will use the Featurizer to manipulate the above block.

1. Create a .ext file with a descriptive prefix.

The prefix to the .ext file should be indicative of the “feature” you
are incorporating, i.e., putting a logo into a report program. For
example:

my_logo.ext
Next you will use the Featurizer to place custom logic into code.

2. Use vi to open your newly created .ext file and insert a start file
command at the top.

When manipulating a block, you must tell the Featurizer where
the block and its function are. You do this by inserting a start file
command in your .ext file. All block commands placed under
that start file “file_name" command are applied to that
file. The syntax for the start file command is:

start file "file_name"

At the top of your newly created .ext file,add in the start file
"file name" command, specifying the .4gl file which contains
the block you are going to manipulate. This .4gl file must be in
double quotes as above.

3. Understart £ile, place the block command that will place
your custom logic into code.

Any of the following block commands will place code differently,
but the result in the final compiled program will be the same:

¢ replace block
e after block
e before block
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Pick any of the above block commands you wish.

Once you have decided, you may insert your block command in
the .ext file. Block command syntax is:

block_command function_name block_name

The function name is 1ogo and the block name is what you wrote
down on the previous page. Be sure your block command is
under your start file command.

Insert the INFORMIX-4GL logic to display your custom logo.

Now add the actual custom Informix logic that will be placed
into the code. In your .ext file under the block command, add one
or two Informix display commands to display a message of your
choice. For example:

display *“This program has been brought to you by *
display "your_name"

End the block with a semi-colon (“;”), and save and exit of the
.ext file.

You can have multiple block commands in an extension file.
Block commands are delimited with a semi-colon.

Merging with the .set File

6-10

Next you will place your modification into code.

1.
2.
3.

Create a .set file with the exact name base.set.

Use vi to create the base. set file.

On the first line, add the prefix to the .ext file you created.
Example base. set file contents:

my_ logo

Using the Featurizer
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Merge and Compile with fg.make

1.

Compile and link the source code with the following command
again:

fg.make

When you type £g.make at the UNIX prompt, you may get a
message such as:

Compiling source files.
main.4gl: failed.

ERROR: /usr/ /Make/program.sh:
Unable to compile these 4gl files:
main.4gl

while compiling

This indicates that a syntax error has occurred. See Appendix A
in this manual for handling syntax errors. Be sure all syntax
errors are fixed before continuing.

Use vi to openmain.4gl.
Find the function you modified and inspect the change.

The Featurizer should have incorporated your block command
into the code.

Run the Program

Run the program.

Is your custom logo appearing?

Embeliish Your Custom Logo

Your custom logo message should appear at the lower left hand cor-
ner of the screen. You can center it so it looks more attractive by using
the Informix at command with the display command. For example,
the following:

display *"your_name® at 7.3

This line positions the message better on the screen.
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Lab Exercise 6b

Objective: To create and incorporate a selection criteria screen into
your report so that the user may limit which customers appear on the
report. You will create the selection criteria .per file, code a function
that handles the selection criteria screen, and place the function call
into code with the Featurizer.

Adding in Report Prompts

Many reports require the end user to enter selection criteria in a
prompt prior to running a report. Using the Screen Code Generator
and Form Painter, you can use the following extension file to auto-
matically hook in these prompts. Follow the general steps outlined
below to link in your query screens:

1. Create a query screen in the Screen Painter.
2. Run the Screen Code Generator.

3. Create an image (report. i £g) file for your report.
4. Run the Report Code Generator.
5

Create the extension file (shown below) and call it in the
base. set file.

6. Run f£g.make to build the report program.

Report Prompt Extension File

Add the following code to an extension file. Notice that you must

supply the name of your prompt screen in three locations within this
extension file. The italicized word screen_name denotes where you
should enter the name of your prompt screen less the .per extension.

start file "Makefile"
libraries
$(fg) /lib/scr.a;

start file "midlevel.4gl"”
function define ml_filter
m smallint,
n smallint;
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replace block ml_filter sel_filter

call socketManager(“screen_name', "query", "default")

let sel_filter = null

let n = fgStack_pop{)

ifn=20

then
let int_flag = true
# set default filter if user continues
let sel_filter = "1=1"

end for

end if;

else
form =1 ton

let sel_filter = sel_filter clipped,

end for

end if;

start fiie "main.4gl"
after block main after_init
let scr_id = "default"

H

at_eof
function switchbox(£funct)
#_define_var - define local variables
define
#_local_var - local variables

funct char(20) # Function to pass on to the screen

fgStack_pop ()

#_post_scr_funct - Post the current function

let scr_funct = funct

#_switchbox - Pass flow control to appropriate screen

case
# put your screen in here

when scr_id = "screen_name" call S_screen_name()
when scr_id = "default® call lib_screen()

#_otherwise - otherwise clause
otherwise let scratch = “no screen*
end case

#_scr_funct - Reset scr_funct upon return

let scr_funct = "

end function
# switchbox()

i
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What is a Posting Program?

A posting program is a report program that performs some special
processing on each row as it prints on the report. This special process-
ing is in the form of SQL activity.

Posting programs can take data from one table and insert into
another:

C orders >—>

POSTING
PROGRAM

(pst_orders>

Posting programs can take data from more than one table and insert

into more than one table:
( pst_orders>

< orders )——»
POSTING
PROGRAM
( items >—> C pst__items)

The two “pre-posting” tables have a one-to-many relationship
between each other, and the two “post-posting” tables also have a
one-to-many relationship. Posting programs can also update a table:

( orders >—> POSTING
PROGRAM

N
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Creating the Posting Program

There are two main steps to creating a posting program with

Report.

Create a report with the Report Writer that will select all rows that
you wish to post.

Use the Featurizer to insert SQL statements that act on each row
as it is processed.

Creating the Report

Create a report that will pull from a table and display all rows to be
posted. The report output itself is ideal because the user can see what
data are to be posted.

Keep in mind when creating a report with the Report Writer:

All values to be posted must be brought into the program. There-
fore, you design your report so that all values to be posted are
brought in by the main SQL statement inmidlevel.4gl.

All values to be posted do not have to be on the report itself. You
may use the “Hidden Fields” capability in the Report Writer to
pull data out of columns that do not appear on the final report.

When posting from two tables, clarify the one-to-many relation-
ship between the two tables. Design your report so there is a
group break on the “one” table.

Filtering criteria: How will you ensure that rows are not re-
g y
posted? Are there some rows that you never want posted?

Inserting the SQL Statements

After you have created the report with the Report Writer and have
generated code for it, use the Featurizer to insert SQL statements into
the appropriate places in code that will post your rows as they are
processed. Typically you will place SQL insert and update statements
into lowlevel. 4gl to post each row as it passes through.
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7-4

Items to keep in mind:

s If posting from one table to another table, place your SQL state-
ment into the on_every_row function.

Here is an example of an SQL insert placed at the end of the on_ev-
ery_row function. It is placed here via a block command in an .ext
file.

#_unit_price - insert “on every row unit_price” code here
let rpt.unit_price = curs.unit_price
#_total price - insert “on every row total_price” code here
let rpt.total_price = curs.total_price
insert into pst_items wvalues
(curs.item_num,
curs.order_num,
curs.stock_num,
curs.manu_code,
curs.quantity,
curs.total_price)
end function
# on_every_row({}

Here, as items table rows pass through the looping phase of the
report, they are inserted into a table called pst_items.

e If posting from two tables that have a one-to-many relationship,
you have two SQL statements: one to post the “one” table’s data,
and one to post the “many” table’s data.

¢ The “many” table’s data are processed by the on_every_row
function, so you place one SQL statement in on_every._row to
post.

¢ The “one” table’s data are handled by the after_group func-
tion or the a_g_ [grouping column] function, so you place
your SQL statement here to post the “one” table’s data.

Here is an example that places code into the a_g_order_num func-
tion. a_g_order_num holds code that is executed after the order
number changes. Again, code is placed here via a block command in
an .ext file.

#_a_order_num - insert after group code here
insert into pst_orders values
(curs.order_num,
curs.order_date,
curs.customer_num,
curs.ship_instruct,
curs.backlog.
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curs.po_numn,
curs.ship_date,
curs.ship_weight,
curs.ship_charge,
curs.paid_date,
curs.pay_code,
curs.ship_method)

Here, as orders table rows pass through the looping phase of the
report, they are inserted into a table called pst_orders.

Note If you use the curs record as you see in the examples, make sure it
contains all the variables needed for posting. It typically will not. You
can add additional variables into your curs record by placing
hidden fields on the report with the Report Writer. When you export
the report, a hidden field shows up as a “more =" parameter in the
select section of the report.ifg file. When you re-generate code,
all supporting logic for hidden fields is created for you in code,
including logic to place extra variables in the curs record.

Using prepare and execute

One key posting technique is to use the Informix prepare and execute
commands in lieu of insert and update.

When you run an SQL insert or update, not only are these statements
executed but they are also preprocessed each time they are run.

The preprocessing and execution stages can be separated, so that the
insert or update is preprocessed only once, and then executed for
each row of the report. You do so with the Informix prepare and exe-
cute commands, which preprocess and run respectively.

Using prepare and execute is ideal for posting programs, which are
notoriously slow due to the large number of SQL statements in them.
With prepare and execute, you preprocess an SQL statement only for
the first row; then you simply execute the preprocessed SQL state-
ment on all subsequent rows.

Instead of coding the Informix insert, you use a prepare and execute
as follows:

if sqgl_prep is null

then
let sgl_str = *insert into pst_items values (?, ?, 2, ?, ?, ?)"
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prepare prep_stmt from sql_str
let sqgl_prep = "Y*

end if

execute prep_stmt using
curs.item_num,
curs.order_num,
curs.stock_num,
curs.manu_code,
curs.quantity,
curs.total_price

The question marks that you see are placeholders in the preprocessed
SQL statement, they are filled with values when the statement is exe-
cuted. When the first row comes through the SQL insert, it is prepro-
cessed and executed with prepare and execute.

A variable is set to indicate that the SQL statement has been pre-
pared, and it stays prepared for the duration of the program. Then, as
each subsequent row comes through, the program is invoked with
execute. Executing a prepared statement takes considerably less time
than executing and preparing an SQL statement.

Using begin work, commit work, and rollback work

7-6

Another posting technique ensures database integrity.

When you are using more than one SQL statement in a posting pro-

gram, there is always a danger that one SQL statement executes suc-
cessfully while another one fails. This means that you have partially
posted a record; for example, a “one” row is inserted but its “many”
rows are not.

Fortunately Informix allows you to define the boundaries of a record.
You can issue an Informix begin work command as the record begins
processing, and then a commit work command when the record has
finished processing. After each SQL statement is executed, a test for
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successful execution is made. If an SQL statement fails, then a roll-
back work command is issued and any SQL statements after the
begin work command that have been executed are undone.

begin work

| f

rollback work

SQl activity | sQl failure

commit work

A begin work is placed in the before_group function or the
b_g_[grouping column] function before any SQL statement. This
is where a record starts processing.

#_b_order_num - insert before group code here
begin work

A commit work is placed in the after_group function or the
a_g_[grouping column] function after any SQL statements. This
is where a record completes its processing.

commit work

end function
# a_g_order_num()
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Section Summary

7-8

The following are various types of posting programs:

e Posting programs that take data from one table and insert it
into another table.

e Posting programs that take data from multiple tables and
insert the data to multiple tables.

e Posting programs that update values in columns.

Creating a posting program is a two-step process: use the Report

Writer to create a report that pulls all values to be posted into the

program, and then use the Featurizer to place SQL statements
that do the actual posting into the code.

It is critical to ensure that all values to post are selected into the
posting program. Use of the “Hidden Fields” capability in the
Report Writer is especially useful for accessing values that do not
appear on a report. ’

The performance of posting programs may be improved by using
Informix prepare and execute commands in lieu of insert or
update.

When posting to multiple tables, it is important to use the begin
work/commit work/rollback work commands of Informix to
ensure database integrity.

Creating Posting Programs
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Lab Exercise 7

Objective: To create an inactivation program, which inactivates cus-
tomers. This type of posting program prompts the user for a cus-
tomer to inactivate, and then inactivates the customer by setting a
flag in the customer table.

This lab uses the Selection Criteria screen you created in the previous
section’s lab. The customer that the user enters into the Selection Cri-
teria screen is the customer to be inactivated.

Create a New Program Directory

1.
2.

5.

cd $SHOME/labs.4gm.

Make a new program directory prefixed with a “p_" and give it
a .4gs extension.

Make sure the entire prefix does not exceed eight characters.
Posting programs are prefixed with a “p_".

cd into your new posting directory.
Copy in all files from your last lab.
You will convert the prior lab’s report to a posting program.

Remove the executable .4gi or .4ge file.

Add a Column with isql

1.

2.
3.
4.

Enter isql and add a column called “inactive” to the cus-
tomer table.

Make its data type char (1) and exit out of isql.
Run the Report Writer.

Load the “Orders Listing” report.
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5. Inthe Report Writer, change the name of the report to “Cus-
tomer Inactivation Report.”

6. Export the Report.
7. Exit the Report Writer.

Generate Code

Generate code on your modified report . ifg file using the Report
Code Generator.

Add an SQL Statement with an .ext File

Next use the Featurizer to place an SQL statement into code. The SQL
statement will be an update which places a “Y” value into the inac-
tive column for the customer that the user selects to inactivate.

1. Usevitoopen lowlevel.4gl.

2. Find the function that handles after group logic for the cus-
tomer number field (a_g_customer_num()).

3. Find the block within the above function that allows you to
place custom after group logic (#_a_customer_num).

This is the block that you will manipulate with the Featurizer.
4, Exit lowlevel.4gl.
5. Create an .ext file with a descriptive prefix.

Now create an .ext file to hold a block command with the modifica-
tion you wish to make. Create an .ext file now (just the file). The pre-
fix to the .ext file should be indicative of the “feature” you are
incorporating, such as:

inact.ext

6. Inyour newly created .ext file, insert a start file command at the
top.

Use the following start file command:

start file "lowlevel.dgl"®
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Which .4¢l file contains the block you are going to manipulate?

Under start file, place the block command that will place
your update statement into code.

The block command should look as follows:
after_block a_g customer num a_customer_num

Insert an SQL update statement to set the current customer’s
inactive column to "Y."

For example, you could use the following SQL statement:

UPDATE customer SET inactive = "N"
WHERE customer_num = curs.customer_num

End the block with a semi-colon (“;”) and save and quit out of
the .ext file.

Merging with the .set File

1.
2.

vi your base.set file.
On the first line, add the prefix to the .ext file you created.

Add only the prefix. Make sure that your selection criteria screen
is kept in the .set file, because your inactivation feature will
depend on the selection criteria feature being in code.

Merge and Compile with fg.make

1.

Start the Featurizer:
fg.make -mf

The £g.make command invokes the Featurizer and merges your
logic into the code. The “-m£” flag instructs £g.make to only
invoke the Featurizer and not compile and link.

Use vi to open lowlevel.4gl and notice your change.

Is your change there?
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3. Complete the compile, and link the source code with the fol-
lowing command again:

fg.make

Run the Program

Use the fglgo runner or type the *4ge filename directly to run the
report program.

Verify Through isql

Enter isgl and select the customer you updated. Is the value of the
inactive column “Y” for this customer?
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Larger Selection Statement Variables

The Report Code Generator now uses larger selection statement vari-
ables to prepare and declare selection statements. This increased size
more than doubles previous capabilities.

Previous Variable Size New Variable Size
ct.sel_join char(200) sel_join char(512)
ct.sel_filter char(200) sel_filter char(2048)
ct.sel_order char(200) sel_orxrder char(512)

ct.sel_stmt char(1024) sel_stmt char(4096)

In addition these variables are now located inmidlevel.4gl
instead of globals. 4gl, and the ct. has been dropped from their
name. This move and subsequent name change gives you easier
access and more control over the selection statement variables; you
can increase their size whenever you near a limitation without having
to change any libraries.

Backward Compatibility

8-2

An early work around to the limited size of selection statements used
block commands and string replacements to increase selection limits.
If you have programs that depend on this work around and you want
to regenerate them, you can use an environment variable and an
options file to maintain backward compatibility.

The rpt_select environment variable takes two options: local
and global. The global option sets all variable values to their
former size, name, and location. This is the option you should use to
maintain backward compatibility. The 1ocal option sets all selection
variables to their new size, name, and location.

You can set the rpt_select variable to global on a system, mod-
ule (4gm) or program level (4gs). By default this variable is pre-set to
local, so all selection variables start with the larger sizes.
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To set on a system level, type rpt_select="global™" in the
report.org file. This file is located in the $fg/codegen/options
directory.

To set on a module or program level, create a report . opt file in the
directory that contains the programs you want to affect. In the
report.opt file, add the rpt_select="global" line.

The mi_ct_sel_compat( ) Function

In addition to the new variables, a new function has also been added
tomidlevel. 4gl. This function, named ml_ct_sel_compat (),
sets local selection variables to any value passed from the command
line or any other initializing method.
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Post Processor Flexibility

8-4

The Report Code Generator lets you customize generated source code
with a post processor. A post processor is useful for many tasks, such
as making global changes to code, replacing or altering code blocks,
and implementing bug fixes.

The £g.report program runs a post processor on the local applica-
tion if the environment variable $1ocal_rpt is set. Use this variable
to point to the name of the program you wish to run on the generated
4GL code.

The same arguments that you pass to £g. report get passed to your
post-processor program.

For example, assume you write an initialization function (say,
ny_init ()) that is more relevant than the generic init () function
that the Report Code Generator creates. You may want main. 4gl to
callmy_init () rather than the init () function. You can set up a
post processor to change the initialization call inmain. 4gl to

my_ init().

Tochange init () nmain.4gltomy_init ():

1. Write a shell script (chg_init, for example) that uses the sed
utility to remove init () and add a call tomy_init (), such as:
#chg_init

sed "s, call init, call my_init, * main.4gl > main.tmp &&
mv main.tmp main.4gl

2. Set your $local_rpt environment variable to the name of the
post-processor script (you might want to set this variable in
your .profile file), for example:

local_rpt=chg_init; export local_rpt

Once the Code Generator completes creating source (.4gl) files, your
local main. 4g1 file contains the function call my_init () rather
than init ().
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Print Statement Block Tag Logic

In previous versions of the Report Code Generator, the
report.4gl file contained a block tag for each report row. These
block tags, which were numbered sequentially, allowed you to create
custom code for each line in the report. In other words, you could use
an extension file and block command to act on any report.4gl
print statement. The following shows an example of the old logic:

format
page header

whenever error call error_handler
#_print_1 - tag for the following print statement
print

column 1, today using "mm/dd/yy*;

let scratch = "CUSTOMER ORDER HISTORY LIST"

let x = 40 ~ (length(scratch) / 2)

print

column x, scratch clipped;

let scratch = pagenc using “"Page: <<<<"

let x = 81 - length(scratch)

print

column x, scratch clipped

$_print_2 - tag for the following print statement
print
#_print_3 - tag for the following print statement
print

column 1, *Customer”
# _print_4 - tag for the following print statement
print

column 1, “"Number®,

column 11, “Name",

column 30, “"Company"”,

column 54, "Phone"
#_print_5 - tag for the following print statement
print

column 1, "-=-eemmm e e mcec—emmcao o ",

page trailer
#_print_6 - tag for the following print statement
print
#_print_7 - tag for the following print statement
print
column 1, "---e-rmr-mmerecemcs e ——— ",
column 41, "-ec—mmem e e “
#_print_8 - tag for the following print statement
print
column 1, pageno using "Page: <<<<";
let scratch = pageno using "Page: <<<<"
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let x = 81 - length(scratch)
print
column x, scratch clipped

This version of the Report Code Generator uses new print statement
block tag logic. Instead of the entire report. 4g1l file having sequen-
tially numbered print statement block tags, now print statement
block tags are numbered according to the control block that contains
them. For example:

format
#_format - Format section

#_page_header - Report block for page header.
#_err - Trap fatal errors.
whenever error call error_handler
#_page_header_l1 - Print statement
call put_vararg(today using usg.today)
call put_vararg("CUSTOMER ORDER HISTORY LIST")
call put_vararg{pageno using usg.pageno)
let header_image = imageManager_getLine(l)
print header_image clipped
#_page_header_2 - Print statement
print
#_page_header_3 - Print statement
let header_image = imageManager_getLine(2)
print header_image clipped
#_page_header_4 - Print statement
let header_image = imageManager_getLine(3)
print header_image clipped
#_page_header_5 - Print statement
let header_image = imageManager_getLine(4)
print header_image clipped

#_end - End of report block.

#_page_trailer - Report block for page trailer.

#_page_trailer_ 1 - Print statement

print

#_page_trailer_2 - Print statement
let header_image = imageManager_getLine(S)
print header_image c¢lipped
#_page_trailer_3 - Print statement
call put_vararg{pageno using usg.pageno)
call put_vararg(pageno using usg.pageno)
let header_image = imageManager_getline(6)
print header_image clipped

#_end - End of report block

As you can see, this new scheme limits the number of lines affected
when you insert a custom print statement. For instance, suppose you
create a report that contains 30 print statements. When the Report
Code Generator constructs your source code (.4gl) files, it adds 30
print statement block tags to your report . 4g1 file, one tag for each
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print statement. The old method numbers these block tags from one
to 30. As mentioned above, the new numbering scheme restarts at
one for each control block.

Now suppose this same report program uses several extension files
containing block commands that act on these print statement block
tags. Using the old method, if a situation arises where you need to
remove a print statement, all your extension files must be reworked.
However, with the new method, you only need to alter the extension
files that reference the modified control block.

Backward Compatibility

Although this new numbering scheme makes modifying reports eas-
ier, you can regenerate your existing report programs with the old
method. The Report Code Generator uses a new variable that controls
which method gets used, namely rpttagtype. This variable, which
you set on a local basis in the report . opt file, accepts one of two
values: block or 1line. By default, the Report Code Generator uses
the new print statement block tag logic, in other words rpttagtype
is set to block. If you want to use the old method, set rpttagtype
to line.

As arule, set rpttagtype to 1ine when you are working with pre-
viously generated programs. In the report . opt file type:

rpttagtype=line

When developing new report programs, use the new numbering
scheme to take advantage of the simplified code and regenerability.
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Custom Image File Block Tags

8-8

Another new feature of the Report Code Generator is custom image
file block tags. You can now add your custom block tags in the format
section of the image file. These block tags, upon code generation, get
placed into the report. 4g1 file. Once in the report .. 4g1 file, you
can use extension files and block statements to customize the source
code. For example, the following image (report . 1 £g) file contains a
custom block tag in the before group control block:

before group of customer.customer_num
{
#_custom_block - Example custom block tag

[£000 [£001 [£002 [£008
Activity Report: [t
Order # PO # Ordered Shipped Paid [t

When this example image file is generated into source code, the cus-
tom block tag gets added to the appropriate line in the report.4gl
file: '

before group of rpt.customer_num
¥_b_customer_num - Before group customer_num

if
rpt.order_num is not null
or rpt.po_num is not null
or rpt.order_date is not null
or rpt.ship_date is not null
or rpt.paid_date is not null
then
let dynamic = true
need 4 lines
else
let dynamic = false
end if

#_custom_block - Example custom block tag

call put_vararg(rpt.customer_num using usg.customer_num}
call put_vararg{rpt.fname)

call put_vararg(rpt.company)

call put_vararg(rpt.phone)

let line_image = imageManager_getLine(7)

print line_image clipped
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Custom tags are useful, because they never change. Whereas print
statement block tags change when new lines are added, custom tags
are completely regenerable. When you create extension files that act
on custom block tags, your modifications are preserved each time
you regenerate the code.

Numbering Scheme Variable

When you create custom block tags in your report . ifg file, you
must decide how you want the print statement block tags in the
report.4gl file to increment. There are two methods. The first
method counts your custom block tags; it is an "absolute" numbering
scheme. The second method, known as "relative,” does not count
your custom block tags, thus the print statement block tags remain
consistent no matter how many custom block tags you add to your
report.ifg file.

In almost every case, the Report Code Generator defaults to the
method appropriate to your situation. However, at times you might
want to specify the non-default method.

To specify the non-default method, use the new rpttagnum variable.
You can set this variable to either absolute or relative. On the
local directory level, use the report . opt file to set this variable. For
example, to set the rpttagnum to absolute, add the following line
to the report . opt file:

rpttagnum=absolute

Note

The rpttagnum variable defaults to a different value depending on
the value in the rpttagtype variable. When rpttagtype is set to
block, rpttagnum defaults to relative. When rpttagtype is
set to 1ine, rpttagnum defaults to absolute.

The following lines of code show an example of both absolute and
relative numbering schemes. Notice how the number of the third
print statement block tag differs between the two methods:
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Absolute Block Tag Numbering Scheme

#_page_header - Report block for page header.

#_err - Trap fatal errors.
whenever error call error_handler

#_pagé_header_l - Print statement

call put_vararg(today using usg.today)
call put_vararg("Syscolumns ")

call put_vararg(pageno using usg.pageno)
let header_image = imageManager_getLine(l)
print header_image clipped

#_custom_tag - Custom block tag
let header_image = imageManager_getLine(2)
print header_image clipped

#_page_header_3 - Print statement
let header_image = imageManager_getLine(3)
print header_image clipped

#_page_header_4 - Print statement
let header_image = imageManager_getLine(4)
print header_image clipped

#_page_header_5 - Print statement
print

#_page_header_6 - Print statement
print

#_end - End of report block.

Relative Block Tag Numbering Scheme
#_page_header - Report block for page header.

#_err - Trap fatal errors.
whenever error call error_handler

#_page_header_1 - Print statement

call put_vararg(today using usg.today)
call put_vararg{"Syscolumns ")

call put_vararg(pageno using usg.pageno)
let header_image = imageManager_getLine(1l)
print header_image clipped

#_custom_tag - Custom block tag
let header_image = imageManager_getLine(2)
print header_image clipped

#_page_header_2 - Print statement

let header_image = imageManager_getLine(3)
print header_image clipped
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#_page_header_3 -~ Print statement
let header_image = imageManager_getLine(4)
print header_image clipped

#_page_header_4 - Print statement
print

#_page_header_5 - Print statement
print

#_end - End of report block.

A good time to use the non-default method is when you add a cus-
tom image file block tag to a report that uses the old print statement
logic (i.e., rpt tagtype=1ine), and you regenerate that report. In
this case, you do not want rpttagnum set to absolute, because
absolute numbers each block tag including your custom tag, which
in turn throws off every extension file that acts on the changed tag
numbers. Instead, set rpttagnum to relative. This setting pre-
serves all the existing print statement block tags. In essence this set-
ting numbers around your custom tag.

Custom Image File Block Tags 8-11
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Block Tags in Makefile

8-12

As you might have noticed already, the Makefile now comes with
generated block tags before each Makefile macro. The new Make-
file style makes including custom libraries and source files into
your generated programs easier. In addition, you inherit all the flexi-
bility and functionality of block statements and extension files, such
as pluggable features and feature sets, without having to use difficult-
to-maintain string replacement logic in block statements. The follow-
ing example Makefile illustrates the new block tags:

332333333 RE LIRS LTL LA ILLLLLIILINLIL TSI L]
# Copyright (C) 1993

# 211 rights reserved.

# Use, modification, duplication, and/or distribution of this

# software is limited by the software license agreement.

# Sccsid: %Z% %M¥ %1% Delta: 3%G%
HUEREERHRERLAHFHERRALS S HE SRS BB R BB SRR G H S S SRR S B USSR S H RS SRR R B SRR RS
# Makefile for an Informix report

#_type - Makefile type
TYPE = program

#_name - program name
NAME = tmp.4ge

#_objfiles - program files
OBJFILES = globals.o lowlevel.o main.oc midlevel.o report.o

#_forms - perform files
FORMS =

#_libfiles - library list

LIBFILES = ../lib.a \
$(fg)/lib/report.a \
$(fg)/lib/user_ctl.a \
$(fg)/lib/standard.a

#_globals - globals file
GLOBAL = globals.d4gl

#_all_rule - program compile rule
all:

@echo "make: Cannot use make. Use fg.make -F for 4GL
compile."
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